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Symbols - Definitions

e CAUTION: Risk of danger. This is a personal danger warning.
Documentation must be consulted in all cases where this symbol is marked.
Failure to acknowledge these warnings could result in personal injury to the
user.

CAUTION: Risk of Electric Shock. This is a personal danger warning.
Documentation must be consulted in all cases where this symbol is marked.
Failure to acknowledge these warnings could result in personal injury to the
user.

CAUTION: Hot Surface. This is a personal danger warning. Documentation
must be consulted in all cases where this symbol is marked. Failure to
acknowledge these warnings could result in personal injury to the user.

Recycle. Items with this symbol indicate that the item should be recycled and
not disposed of as general waste.

I = B

Warnings and cautions are placed throughout this manual for the convenience
of the reader. However, the absence of warnings and cautions do not preclude
the use of proper caution and handling. Usual precautions are recommended
to be taken at all times, either written or otherwise, to avoid personal injury or
damage to ASD equipment.
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The Power Supply is intended for Indoor Use Only

When using an electrical appliance, basic safety precautions should always be
followed.

Danger- To reduce the risk of electric shock read all instructions before using
the power supply. A power supply should never be left unattended when
plugged in. Always unplug the power supply from the mains socket
immediately after using.

Warning- To reduce risk of burns, fire, electric shock or injury to persons or
animals:

1. Use this power supply only for its intended use as described below.
2. Do not use outdoors.

3. Do not allow to be used as a toy. Pay close attention when this power
supply is used by, or near to, children.

4. Use only attachments recommended by the manufacturer.

5. Never operate the power supply if it has a damaged cord or plug, if it has
been dropped or damaged or if it has fallen into water. In such cases return the
power supply to an authorized dealer or service center for examination or
repair.

6. Never drop or insert an object into any openings.

7. Do not operate where aerosol (spray) products are being used or where
oxygen is being administered.

8. The power supply should be used near to a convenient and easily accessible
mains socket.
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Chapter 1 Introduction

The FieldSpec® 3 Spectroradiometer is a general-purpose spectrometer
useful in many application areas requiring the measurement of reflectance,
transmittance, radiance, or irradiance.

* A spectrometer is an optical instrument that uses detectors other than
photographic film to measure the distribution of radiation in a particular
wavelength region.

* A spectroradiometer is a special kind of spectrometer that can measure
radiant energy (radiance and irradiance.) Unlike other ASD
spectrometers, the FieldSpec instrument can perform radiance
measurements by default coming from the factory, because its Fiberoptic
cable is fixed.

Note: The Fiberoptic cable significantly affects the factory calibration
required to measure radiance. Many of the other ASD
spectrometers can detach and even interchange Fiberoptic cables,
which can affect the accuracy of such calibrated radiance
measurements.

The FieldSpec spectroradiometer is specifically designed for field
environment remote sensing to acquire visible near-infrared (VNIR) and
short-wave infrared (SWIR) spectra. Remote sensing is defined as the art and
science of obtaining information about an object without being in direct
physical contact with the object.

The FieldSpec spectroradiometer is a compact, field portable, and precision
instrument with a spectral range of 350-2500 nm and a rapid data collection
time of 0.1 second per spectrum. The FieldSpec spectroradiometer is also
offered in various subsections of the spectral range.

While the most highly regarded features of the FieldSpec spectroradiometer
are performance and field-portability, this instrument also performs well in
the laboratory.

© 2010 ASD Inc. 1 FieldSpec® 3 User Manual
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Features and Advantages
Accurate and Precise - High signal-to-noise ratio and superior
repeatability of results for better identification and analysis of materials.

Rugged and Transportable - Resistant to vibration and changes in
temperature or humidity.

Fast - 10 spectra per second data collection for the entire 350-2500 nm range.
» 0.1 second scanning time provides an accurate average every second.
»  Users can quickly scan several areas when analyzing bulk samples.

» Rapid analysis allows screening all or most samples instead of spot
checking.

Compatible - Works with off-the-shelf chemometrics software
(Grams™ PLS plus/IQ and Unscrambler®).

1.1  Hardware Specifications

This section contains details about the FieldSpec spectroradiometer.

1.1.1  Physical Specifications

Height 12.7 cm 5 inches
Width 35.6 cm 14.5 inches
Depth 29.2 cm 11.5 inches
Weight 5.6 kg 12 Ibs

e Durable satin powder coat finish with teal urethane end-caps and handles
* All vital components are in a dust-proof enclosure and EMI sealed

*  Fiberoptic inputs directly to each spectrometer

ASD Document 600540 Rev. J 2 FieldSpec® 3 User Manual
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1.1.2  Power Input and Output
AC Power Supply Type Auto ranging, Switching, SELV
AC Input 90-240 VAC, 50/60 Hz
DC Input +12 VDC, 60 W
Accessory Power Port Output, +12 VDC, 27 Watt (max).
(front of instrument)
Instrument Configuration Power Rating Maximum
350-1050nm 12 VDC, 45 Watt
350-1800nm 12 VDC, 50 Watt
1000-1800nm 12VDC, 50 Watt
1800-2500nm 12 VDC, 50 Watt
1000-2500nm 12 VDC, 60 Watt
350-2500nm 12 VDC, 60 Watt
The near infrared (NIR) is also called the short-wave infrared (SWIR).
1.1.3  FieldSpec Wavelength Configuration
Wavelength Name Wavelength Range
VNIR-SWIR1-SWIR2 350 - 2500 nm
VNIR only 350 - 1050 nm
VNIR-SWIR1 350 - 1800 nm
SWIRI only 1000 - 1800 nm
SWIR1-SWIR2 1000 - 2500 nm
SWIR2 only 1800 - 2500 nm
VNIR & SWIR2 350 - 1050 nm and 1800 - 2500 nm
ASD Document 600540 Rev. J 3 FieldSpec® 3 User Manual
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The spectral resolution is:

¢ 3 nm (Full-Width-Half-Maximum) at 700 nm.

* 10 nm (Full-Width-Half-Maximum) at 1400 nm.
* 10 nm (Full-Width-Half-Maximum) at 2100 nm.
The sampling interval is:

* 1.4 nm for the spectral region 350-1000 nm.

* 2 nm for the spectral region 1000-2500 nm.

The FieldSpec spectroradiometer may be configured to have three separate
holographic diffraction gratings with three separate detectors. Each detector is
also covered with the appropriate order separation filters to eliminate second
and higher order light.

* VNIR: 512 element silicon photo-diode array for the spectral region
350-1000 nm.

*  SWIRI: graded index, TE-cooled, extended range, InGaAs, photo-diode
for the spectral region 1000 nm to 1830 nm.

*  SWIR2: graded index, TE-cooled, extended range, InGaAs, photo-diode
for the spectral region 1830 nm to 2500 nm.

1.1.4  Interface Requirement

The FieldSpec spectroradiometer has 10/100 Base T Ethernet port. The
spectroradiometer with an Ethernet cross-over cable can be directly connected
to the Ethernet port provided on many laptop computers.

The FieldSpec spectroradiometer can communicate with the instrument
controller using an 802.11b wireless card. When supplied by the customer, the
instrument controller must be 802.11b compatible.

The FieldSpec spectroradiometer uses industry standard components. It has
the same general connection speed and distance capabilities as other 802.11b
wireless devices.

For the best performance, ensure a clear line-of-sight between the
spectroradiometer and instrument controller. Obstructions or radio frequency
interference in close proximity can cause loss of communication or
significantly shorten the communication range.

Note:  For information about configuration of the Ethernet card and cable, please
refer to the Installation Manual.
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1.1.5 Standard Accessories

*  FieldSpec® 3 Spectroradiometer

e FieldSpec® 3 User Manual (PDF on Flash Drive)

* Instrument Controller: ASD-approved laptop computer
*  RS3 Software Pack

* 1.5 meter FR Low OH Fiberoptic Cable

*  Power Supply 12V

* NiMh Battery (12 V, 9000 mA hour) with Charger and 6 ft.
Battery-to-instrument Power Cable

*  Power Adapter with 6 m (20 ft) Cable for Automobile Cigarette Lighter
When using this adapter, turn off the vehicle engine. Electromagnetic
fields from the engine can generate noise in the acquired signals.

* 1.5 meter Instrument-to-Probe Accessory Power Cable

*  Remote Trigger with LEDs and Velcro Pads

e RJ45 CAT 5e UTP Ethernet, Shielded, Crossover Cable

* 64 MB (min.) Flash Drive Memory USB Flash Drive

*  Mylar Wavelength Reference

*  FieldSpec Pistol Grip

» Laptop Carrier (Belly Board) Equipped with Pistol Grip Holder

e Ergonomic Pro-Pack with built-in rain protector, sample storage
compartment, instrument controller (laptop) compartment, and two
battery pouches designed for the hip belt

*  Magnifier for Fiber Checker

*  Shipping Trunk: Durable, air tight, wheeled, fold down handle, and foam
filled with cutouts to protect the instrument and many accessories
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1.2 Computer Requirements

The instrument controller is a computer that manages the FieldSpec
spectroradiometer, stores data, and processes the results.

The standard FieldSpec spectroradiometer includes a laptop computer, or the
instrument controller.

The minimum requirements for the instrument controller are:
* 1.2 GHz Pentium or better notebook or PC-w/monitor

* 256 MB RAM or more

e 20 GB of free disk space

* 1024 x 768 or better graphics resolution

*  24-bit color or better - 32-bit recommended

»  Ethernet port: 10/100 Base T Ethernet interface

*  (Optional) Ethernet wireless (WiFi) adaptor: PCMIA, USB, or built-in
that is compatible with the 802.11b standard

*  (Optional) Serial communications port (or USB port) for GPS receiver
(only needed if you want to use GPS)

*  (Optional) NMEA compatible GPS receiver

1.3  Software Requirement

The instrument controller requires the following software:

*  RS3 Software from ASD

*  Microsoft Windows® 95/98/NT/2000/ME/XP Operating System
e Microsoft Internet Explorer 6.0 or better

Users need a basic understanding of the Microsoft Windows operating system
including software installation.

International customers using non-English versions of Windows must alter
the Regional Settings under Start->Settings->Control Panel. The
default language must be set to English (United States) in order for the
software to be registered and operate correctly. The numbering format must
also be set to English.

ASD Document 600540 Rev. J 6 FieldSpec® 3 User Manual



AASDME‘ www.asdi.com Chapter 1 Introduction

1.4 Theory of Operation

The FieldSpec spectroradiometer measures the optical energy that is reflected
by, absorbed into, or transmitted through a sample. Optical energy refers to a
wavelength range that is greater than just the visible wavelengths, and is
sometimes called electromagnetic radiation or optical radiation.

In its most basic configuration, the spectroradiometer views and detects the
form of radiant energy defined as radiance. With accessories, various set-ups,
and built-in processing of the radiance signal, the FieldSpec
spectroradiometer can measure:

» spectral reflectance,
e spectral transmittance,
* spectral absorbance,
» spectral radiance, and

» spectral irradiance.
Fiberoptic Collection of Reflected/Transmitted Light

Optical energy is collected through a bundle of specially formulated optical
fibers, precisely cut, polished, and sealed for extremely efficient energy
collection. The fibers themselves are of low OH composition providing the
maximum transmission available across the wavelength range of the
instrument.

Inside the FieldSpec® 3 Spectroradiometer

The fiber cable delivers the collected optical energy into the instrument,
where it is projected onto a holographic diffraction grating. The grating
separates and reflects the wavelength components for independent
measurement by the detectors.

Visible/Near-Infrared (VNIR)

The Visible/Near-Infrared (VNIR: 350-1000 nm wavelength) portion of the
spectrum is measured by a 512-channel silicon photodiode array overlaid with
an order separation filter. Each channel (or detector) is geometrically
positioned to receive light within a narrow (1.4 nm) range. The VNIR
spectrometer has a spectral resolution (full-width half maximum of a single
emission line) of approximately 3 nm at around 700 nm.

Each detector converts incident photons into electrons. This photo current is
continually converted to a voltage and is then periodically digitized by a
16-bit analog-to-digital (A/D) converter. This digitized spectral data is then
transmitted to the instrument controller for further processing and analysis by
the controlling software.
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The 512-channel array permits the entire VNIR spectrum to be scanned in
parallel at 1.4 nm wavelength intervals. A single sample can be acquired in as
little as 17 ms.

Short-Wave Infrared (SWIR)

The Near-Infrared (NIR), also called Short-Wave Infrared (SWIR), portion of
the spectrum is acquired with two scanning spectrometers:

*  SWIRI for the wavelength range of 1000 nm to 1830 nm
*  SWIR?2 for the wavelength range of 1830 nm to 2500 nm

The SWIR scanning spectrometers have one detector for SWIR1 and another
for SWIR2. This is different from the VNIR spectrometer, which has an array
of 512 detectors. Thus, SWIR spectrometers collect wavelength information
sequentially rather than in parallel.

Each SWIR spectrometer consists of a concave holographic grating and a
single thermo-electrically cooled Indium Gallium Arsenide (InGaAs)
detector. The gratings are mounted around a common shaft that oscillates
back and forth through a 15 degree swing. As the grating moves, it exposes
the SWIR1 and SWIR2 detectors to different wavelengths of optical energy.
Each SWIR spectrometer has ~600 channels, or ~2 nm sampling interval per
SWIR channel. The spectroradiometer firmware automatically compensates
for the overlap in wavelength intervals.

Like the VNIR detectors, the SWIR1 and SWIR2 detectors convert incident
photons into electrons. This photo current is continually converted to a
voltage and is then periodically digitized by a 16-bit analog-to-digital (A/D)
converter. This digitized spectral data is then transmitted to the instrument
controller for further processing and analysis by the controlling software.

The grating is physically oscillating with a period of 200 ms. It performs a
forward scan and a backward scan, resulting in 100 ms per scan. This is the
minimum time required for any SWIR samples, or full-range samples.

Communicating with the Instrument Controller (Computer)

The FieldSpec spectroradiometer communicates with the instrument
controller using a cross-over Ethernet cable or Wireless Ethernet (WiF1)
interface. The amount of data that is sent depends on the configuration of the
spectroradiometer.

* A single sample of VNIR is ~1024 bytes
* A ssingle sample of SWIR1 is ~2400 bytes
* A single sample of SWIR2 is ~2400 bytes

A full-range FieldSpec spectroradiometer can create packet data sizes over
5 KB. Other single or dual range configurations of the spectroradiometer
create smaller data packets (adding the packet sizes as above.)
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When features for spectrum averaging (or sample count) are turned on within
the application software on the instrument controller, the averaging is
performed at the spectroradiometer.

Dark Current Measurement

Note:

Dark Current (DC) refers to current generated within a detector in the absence
of any external photons. DC is the amount of electrical current that is inherent
in the spectrometer’s detectors and other electrical components and is additive
to the signal generated by the measured external optical radiation.

Noise is the uncertainty in a given measurement, one channel at a time. Noise
by definition is random. Noise can be reduced by using more samples and
averaging the signal. Dark Current is different from noise, because it is
relatively stable and can be characterized.

This manual uses DC to refer to all systematic contributions to the detector
signal. DC is a property of the detector and the associated electronics (not the
light source). DC varies with temperature. In the VNIR region, DC also varies
with integration time.

Whenever DC is taken, a mechanical shutter is used to block off the entrance
slit of the VNIR spectrometer so the signal can be measured. This signal is
subtracted from each subsequent spectrum until another DC is taken. The
SWIR spectrometers take and subtract DC on every scan.

The DC measurement can be updated at any time, but should be updated more
frequently in the beginning of a given session while the instrument warms up.

The VNIR spectrometer is fitted with a unique software and hardware
combination feature called Driftlock. Driftlock corrects for DC changes over
time. It automatically updates DC for every measurement by looking at a
series of masked pixels at the front portion of the VNIR array. The Driftlock
feature corrects for the majority of DC variation over time.

White Reference

A material with approximately 100% reflectance across the entire spectrum is
called a white reference panel or white reference standard.

The raw measurement made by the spectroradiometer is influenced by both
the sample and the light source. An independent measure of the light source
illumination on a reference of known reflectance is required to calculate the
reflectance of the sample. The use of a white reference standard with near
100% reflectance simplifies this calculation.

Reflectance and transmittance are inherent properties of all materials and are
independent of the light source.

Reflectance is the ratio of energy reflected from a sample to the energy
incident on the sample. Spectral Reflectance is the reflectance as a
function of wavelength.
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Transmittance is the ratio of the radiant energy transmitted through a sample
to the radiant energy incident on the surface of the sample. Spectral
Transmittance is the transmittance as a function of wavelength.

Relative reflectance is computed by dividing the energy reflected from the
sample by the energy reflected off a white reference panel or standard.

Absolute reflectance is computed by multiplying the relative reflectance by
the known reflectance of the white reference panel.

With the reflectance of the reference standard available and known, the ASD
RS3 or Indico applications can compute the absolute reflectance or
transmittance for the material being sampled.

Accessories for Light Sources and Probes

ASD offers several accessories for:
*  Delivering illumination to the sample.
*  Collecting reflected or transmitted light from the sample.

*  Collecting reflected or transmitted radiance and irradiance from the
sample (where solar light is the primary source of illumination).

* Transmitting the collected light to the spectrometer.

Some accessories, such as many of the optional foreoptic probes, rely on other
illumination sources, and even solar light.

ASD Document 600540 Rev. J 10 FieldSpec® 3 User Manual



Chapter 2 Setup

Inspect the shipping container and take careful notes regarding any damage
that might have occurred during shipping.

Note:  Save all packing materials, foam spacers, and paperwork for possible future
use.

Figure 2-1 FieldSpec spectroradiometer carrying case and foam inserts.
Prepare a clear space on a sturdy bench or counter, ideally, a space near a
wall-current receptacle and the controlling computer.

Carefully open the shipping container following all instructions and
orientation labels on the container.

2.1 Unpacking the Instrument

Step 1 Carefully remove the instrument from its shipping case.

Use the nylon straps at the top of the Ergonomic Pro-Pack and the hip belt at
the bottom.

© 2010 ASD Inc. 11 FieldSpec® 3 User Manual
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Figure 2-3  Placement of the Ergonomic Pro-Pack.

Step2  Place the Ergonomic Pro-Pack on a flat surface with the shoulder straps
towards the floor.
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Figure 2-4 Removing the instrument controller from the pack.

Step3  Remove the instrument controller from its compartment on the outside of the
Ergonomic Pro-Pack.

Figure 2-5 Removing the FieldSpec spectroradiometer from the Ergonomic Pro-Pack.

Step4  Undo the five (5) plastic connectors that hold the FieldSpec spectroradiometer
in the Ergonomic Pro-Pack.
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Figure 2-6  FieldSpec spectroradiometer front-view showing fiber connection and
power output.

The remaining portion of the case is designed to hold the various accessories
that may have been purchased with the instrument. There are specific
locations for the Contact Probe, Hi-Bright Muglite, Spectralon, battery pack,
and miscellaneous power cables.

WARNING! The fiber cable should never be stored with a bend of less
than a 5" diameter for long periods of time, the cable can
be damaged with undetectable longitudinal fractures that
can cause light leakage and weaker signals.

2.2 Power Supply

The FieldSpec spectroradiometer requires input power to be 12 VDC (60 W).
It does not contain an internal power supply to convert AC voltage to DC, nor
does it have internal batteries.

The three options for providing the spectroradiometer with the appropriate
DC voltage are:

* An external power supply that converts 100 VAC to 240 VAC (50 Hz or
60 Hz) to 12 VDC (shown in Figure 2-7).

* An external battery pack that delivers 12 VDC.

* An external adapter for vehicle cigarette lighters (sold separately and
should not be used with vehicle engine running).

Use only ASD approved power supplies or connectors to
A power the instrument.
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Figure 2-8 Portable battery pack (one on each side of hip belt)

The Ergonomic Pro-Pack has two pouches on the hip belt, either of which can
be used to hold the battery. However, the battery should be on the opposite
side from where the Fiberoptic cable will be.

Figure 2-9 FieldSpec spectroradiometer power connector which plugs into the
instrument.

Insert power (battery or power supply) into the receptacle on the back panel
labeled “INPUT 12 VDC 60 WATT”. Lock the connector in place by
twisting the barrel end of the connector clockwise.
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Figure 2-10 FieldSpec spectroradiometer back panel showing Ethernet connection,
power switch, and power input jack.

2.3 Ethernet Cables

For Information about configuration of the Ethernet card and cable please
refer to the Installation Guide. Only use shielded Ethernet cables to reduce
electromagnetic interference with the instrument.

The instrument will function in wireless mode if the Ethernet cable is left
unattached between the computer and the instrument. The instrument will
function in Ethernet cable mode if the computer and instrument are connected
by the Ethernet cable. To communicate in Ethernet cable mode, plug the
shielded cross-over Ethernet computer cable (as shown in Figure 2-11) into
the Ethernet ports of the FieldSpec spectroradiometer and your instrument
controller. Figure 2-10 shows the back panel containing the Ethernet port,
which is labeled “RJ45/ETHERNET”.

Figure 2-11 Shielded cross-over Ethernet cable.
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24 Accessory Power Port

The accessory power port is located on the front of the unit, as shown in
Figure 2-12. This port is where external accessories, such as the Contact
Probe or Source Probe attach to receive power from the spectrometer.

Figure 2-12 Enhanced view of the front panel with the Fiberoptic cable connector, port
for remote trigger, and accessory power port for probe.

The accessory power port is provided for optional ASD approved accessories.
Attach the large connector end of the cable into the accessory power port of
the front panel. Attach the other end of the power cable into the Contact
Probe, Hi-Brite MugLite, or other ASD approved accessory.

Please contact ASD for information about these accessories.

WARNING! Never attempt to use unauthorized accessories on the
accessory power port.

Figure 2-13 Cable used from the FieldSpec spectroradiometer accessory power port to
the Contact Probe, MugLite, or other authorized ASD accessory.
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2.5 Pistol Grip

The pistol grip is standard with the FieldSpec spectroradiometer, as shown in
Figure 2-14. The pistol grip has a 25 degree field-of-view, full conical angle.

Figure 2-14 Pistol grip components

Components of the pistol grip (from left) (1) modified ASD pistol grip, (2)
grey nut and (3) strain relief.

Figure 2-15  Using the fiberoptic cable with the pistol grip.
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The fiberoptic cable (1) feeds into the rear of the pistol grip (2). The strain
relief and nut are installed at ASD.

Note:  Ifthe grey nut and strain relief get separated, the smooth side of the grey nut is
inserted into the pistol grip and the rough edge of the grey nut is inserted into
the strain relief.

Ensure that the fiberoptic tip is fully seated into the nose of the pistol grip.
You will feel the fiberoptic “click” into the housing.

Figure 2-16  Fully assembled pistol grip
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If there is concern that the fiberoptic is not fitting snugly in the pistol grip the
set screw on the top of the pistol grip may be gently tightened with a 1/8” flat
blade screwdriver. The set screw should be tightened just enough to hold the

fiberoptic cable in place but still allow it to be pulled out with minimal force.
Tightening it so the cable will not come out is a special case.

Figure 2-17  Tightening the fiberoptic in the pistol grip

Caution! DO NOT pull hard on the cable once the set screw is tightened! Pulling hard on
the cable could potentially break the cable fibers. The set screw MUST be
loosened in order to remove the fiberoptic cable from the pistol grip.

Note: Under the plastic cap at the base of the pistol grip there is a factory adjusted set screw, do
not attempt to adjust this set screw.

The red-dot scope (sold separately) has a battery compartment is on the top of
the pistol grip.
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Figure 2-18 Pistol grip with red-dot scope (sold separately), one degree
field-of-view (sold separately), and trigger (standard) attached.

2.6 External Trigger

An external trigger is standard with the FieldSpec spectroradiometer.

The LEDs on the trigger are bright enough to be seen even on a sunny day.
The LEDs are lit up when the trigger is pushed (briefly) and will turn off when
the capture is complete. Figure 2-19 shows the trigger switch with its LEDs.

The trigger plugs into the spectroradiometer near the Fiberoptic cable, as
shown in Figure 2-20.

Figure 2-19 External trigger
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Figure 2-20 External trigger cable plugged into the FieldSpec spectroradiometer.

The trigger comes with several pieces of mated velcro, which are intended for
use with several accessories. Place a piece of hook velcro onto the trigger;
place pieces of mesh velcro onto the accessories, as shown in Figure 2-21.

Figure 2-21  The trigger and the Pistol Grip.

Note:  Accessories such as the pistol grip should have pieces of mesh velcro placed
on both sides so that the trigger can be used right- or left-handed.
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2.7 Laptop Carrier (Belly Board)

The laptop carrier has two intended configurations:

*  With the neck strap, the laptop carrier can hold the instrument controller
without the Ergonomic Pro-Pack when the equipment is carried into the
field by two people.

*  Without the neck strap, the laptop carrier can be attached directly to the
plastic snaps on the shoulder straps of the Ergonomic Pro-Pack when one
person operates the instrument.

Before taking the spectroradiometer into the field for the first time, place
matching velcro strips on the instrument controller (bottom) and laptop carrier
(top) using the following procedures.

Attaching velcro to the instrument controller and laptop carrier

Step 1

Step 2
Step 3
Step 4

Remove the spectroradiometer and instrument controller from the Ergonomic
Pro-Pack.

Put on the empty Ergonomic Pro-Pack and fasten the belt.
Adjust the shoulder straps of the Ergonomic Pro-Pack for comfort.

Detach the laptop carrier from the neck strap and attach it to the shoulder
straps of the Ergonomic Pro-Pack, as shown in Figure 2-22.
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Figure 2-22  Laptop Carrier attached to shoulder straps of the Ergonomic Pro-Pack.

Step 5
Step 6

Step 7
Step 8

Step 9
Step 10

Note:

Step 11

Step 12

Adjust the straps of the laptop carrier for comfort and utility.

Hold onto the instrument controller at all times. Set instrument controller on
the laptop carrier temporarily and observe how close to your body it can be
placed on the laptop carrier while still allowing comfortable access to the
keyboard. Remember this placement and set the instrument controller on a
table.

Remove the laptop carrier from the Ergonomic Pro-Pack.

Locate the two pairs of velcro strips (mating hook side and mesh side)
supplied with the laptop carrier.

Leave the hook and mesh velcro strips mated.

Remove the backing from the adhesive on the hook side of one strip and place
this adhesive side down onto the laptop carrier an inch or so away from the
curve.

Do not place velcro over the battery compartment on the instrument
controller. This will interfere with battery replacement!

Press down firmly on the velcro and smooth out so that the adhesive can stick
to the laptop carrier.

Repeat Step 9 through Step 11 with the other velcro strip but place it a couple
of inches or so away from the other strip. This is shown in Figure 2-23.
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Step 13 The pistol grip holder provides a convenient location for the pistol grip to be
stored when not in use.

Figure 2-23  Placing velcro strips on the laptop carrier and instrument controller.

Step 14  With the hook and mesh velcro still mated, remove the backing from the
adhesive side on the mesh side of one strip.

Step 15  Recall the placement of the instrument controller on the laptop carrier from
Step 6. Set the instrument controller onto the exposed adhesive of the mesh
side of the velcro. Press down firmly.

Step 16  Gently separate velcro of the instrument controller from that of the laptop
carrier. Smooth over the velcro strips on both the instrument controller and
laptop carrier.

Step 17  Repeat from Step 14 for the other velcro strip.
The end result is shown in Figure 2-25.

Step 18  The laptop carrier is equipped with a pistol grip holder on the right-hand side.
The pistol grip holder can be unscrewed and moved to the left-hand side of
the laptop carrier, if necessary. It is recommended that the pistol grip holder
is removed when storing the laptop carrier in the shipping trunk.
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Figure 2-24  Placing the pistol grip onto the pistol grip holder.

Figure 2-25 The laptop carrier with instrument controller and neck strap.
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Chapter 3 Usage and Maintenance

For safety reasons and to prevent damage to the instrument, please review the
following safety precautions. All operators should be familiar with this
information.

3.1 Light Sources

AN

Use only light sources supplied by ASD Inc. Light sources supplied by ASD
are designed to provide levels of illumination and stability of output that
complement the performance of ASD instrumentation.

Never touch the light source’s bulb and avoid contact with
hot metal components near the bulb! Heat transfer from
the light source may make these metal components
uncomfortably warm to the touch.

* Prevent dirt and oils from contacting the bulb and reflector.

» Do not touch the glass envelope of the bulb. Oils on the hand may transfer
to the glass envelope, this can significantly affect the bulb temperature
and corrupt important operating physics of the bulb.

Note: Please refer to the ASD Accessories Manual or the instructions for
that specific accessory for detailed information.

3.2 Access and Ventilation

When using inside, provide adequate room ventilation for the
spectroradiometer. Insufficient ventilation can result in overheating of the
spectroradiometer and subsequently corrupted data and possibly physical
damage to the spectroradiometer.

Do not cover the vents of the instrument.

Do not place objects on the unit or its power supplies. Prevent objects from
obstructing ventilation slits.

© 2010 ASD Inc.
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Keep objects and spills from entering or falling onto the instrument, power
supplies, and software disks.

3.3 Cleaning

Step 1  Turn off the unit.

Step2  Disconnect from all power.

Step3  Allow the unit to cool down.

Step4  Clean unit with a slightly damp cloth and mild soap.

Note: Be sure all soap residue is removed and all surfaces are dry before
use.

3.4 Annual Maintenance

ASD recommends that the instrument be serviced once a year. This will
ensure the proper function of the instrument. Annual maintenance is covered
under ASD's warranty or the extended service contract. Annual maintenance
can be purchased separately. If you are interested in purchasing annual
maintenance or an extended service contract, please contact your sales
representative.

3.5 Returning Instrument to ASD for Service

In order to return the instrument to ASD for maintenance or repair, a Return
Merchandise Authorization (RMA) must be issued by ASD technical support.
The RMA includes scheduling details, contact information, shipping
instructions, as well as a brief description of the maintenance or repair
requirements. Please contact the technical support department at
303-444-6522 or support@asdi.com.
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Fiberoptic Interface

ASD offers a variety of fiberoptic cable lengths to interface with the
FieldSpec spectroradiometer. These fiberoptic cables are used for reflectance,
transmittance, radiance, or irradiance measurements.

The fiberoptic cable is routed straight through the front panel to the
spectrometer. The FieldSpec spectroradiometer is able to accurately measure
radiance and irradiance in absolute units, because there is no front panel
connector to add uncertainty in the throughput of the instrument.

fiberoptic cables should be loosely coiled and stored in the compartments
provided. All accessories should be stored in the designated compartments of
the carrier or in a separate protective case.

41 Fiberoptic Cables

WARNING!

The Fiberoptic cable is made up of fifty-seven (57) randomly distributed glass
fibers. Nineteen (19) of these fibers are 100-micron and are distributed to the
VNIR region. The remaining thirty-eight (38) fibers are 200-micron and are
evenly divided between the two SWIR regions. All fifty-seven fibers are
housed in a plastic sheath. A standard cable has a diameter of 0.19 inches and
is an f2 cable.

The fibers are protected by a metal spiral inside the black cable casing. If
there are kinks in the cable, the fibers are not necessarily damaged. If,
however, the cable has been crunched so severely that the protective metal
spiral can be seen, the chances are high that the fibers have also been
damaged. Each broken fiber results in a ~5% loss of response.

The Fiberoptic cable should never be stored with a bend of less than a 5"
diameter for long periods of time.

© 2010 ASD Inc.
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The fibers can be damaged by coiling the cable up too tightly. If left in a tight
coil for longer than a week, the fibers are likely to develop longitudinal
fractures that will not be detectable. These fractures in the fiber will cause
light leakage, resulting in a weaker signal. The Fiberoptic cables should be
stored by placing them loosely within the netting compartment on the
instrument or on the Fiberoptic spool.

Tips on care for the Fiberoptic cable:

* Do not pull or hang the spectroradiometer by the Fiberoptic cable.

* Do not use wires, ties, or clamps to tightly attach the Fiberoptic cable to
objects, this may pinch or penetrate the protective jacket thereby
damaging the fibers inside.

*  Avoid whipping the Fiberoptic cable, dropping it, or slamming it into
objects, this can cause fractures to the glass fibers.

* Avoid twisting the Fiberoptic cable, such forces may cause fractures to
fibers.

While the tip of the Fiberoptic cable is not particularly susceptible to damage,
a tip cover is recommended to protect against abrasion and exposure to
contamination. Replacement covers can be made by cutting pieces of
eighth-inch shrink tubing to about 1.5" lengths and shrinking them onto the
fiber cable tip. They will slide on and off the cable easily.

The loss in response is further amplified when “jumper” cables are utilized.
Jumper cables are Fiberoptic cables that can be attached to the fixed cable via
an SMA adapter. The loss on the jumpers is largely due to the attenuation at
the junction between the built-in cable and the jumper.

4.2 LED Check for Fiberoptic Cable

WARNING!

Step 1
Step 2

The FieldSpec spectroradiometer allows you to perform a visual verification
of the Fiberoptic cable using built-in LEDs, a magnifier placed on the
Fiberoptic cable, and the Fiber Check software.

The Fiber Check utility produces rapid flashing lights in the SWIR 1
and 2 region's optical fibers. If you are susceptible to epileptic seizures,
exercise caution or avoid using the Fiber Check utility.

Remove any fore optic accessories from the spectrometer’s Fiberoptic cable.

Attach the magnifier to the end of the Fiberoptic cable, as shown in
Figure 4-1.
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Figure 4-1  Magnifier for testing the Fiberoptic cable.

Step3  On the instrument controller, exit any ASD applications that might be running
and communicating with the unit. Such applications include RS3 and Indico.

Step4  Ensure that the spectrometer is turned on.

Step5  Start the Fiber Check application from the Start menu under
All Programs->ASD Programs->RS3 Tools->Fiber Check.

R S - |

~ P Address

f10.1.1.7 @

~ Fiber

Tvmic T Swirl [ Swir?

Check,

Figure 4-2  Fiber Check Program

Step 6  Ensure the IP address configured is the one for your spectrometer.
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Step 7 Use the mouse to select the check box for the LED to turn on: VNIR, SWIRI,
or SWIR2. One or more may be selected at once.

Note: If arange is selected that the spectrometer does not have, that
particular LED will not be available to turn on. Nothing will be
harmed.

Step 8  Select the Check button which turns on the selected LEDs.

Step9  Look through the magnifier to see which fibers light up.

*  Count the number of fibers that show light. Refer to Details about the
Fiberoptic Cable and LEDs.

» Ifapplicable, use the check boxes and the Check button shown in
Figure 4-2 to turn on and off different LEDs to help determine which
range might be affected.

Note: The RED LED for VNIR may be hard to see when the other
ranges are enabled.

Figure 4-3 Internal spectrometer LED shining to test Fiberoptic cable.
Step 10 When finished, shutdown the Fiber Check application.
Details about the Fiberoptic Cable and LEDs

e The LEDs will only turn on for the ranges installed in the spectrometer.
Selecting one that the spectrometer does not have will not cause a
problem.

*  Each range has a different LED color so that the fibers in the cable that
are associated with it can be seen: RED for VNIR; WHITE for SWIR1;
GREEN for SWIR2.

*  The fiber bundle for each range contains 19 fibers.

» Each broken fiber results in a 5.26% loss of response in that particular
range (VNIR, SWIRI, or SWIR2).
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The instrument can be successfully used with a few broken fibers in each
range, although with a reduction in signal strength.

For severely damaged Fiberoptic cables, send the instrument back to ASD
Inc. in the carrying case for repairs.

4.3 Fore Optic Discussion

The Fiberoptic cable provides the flexibility to adapt the instrument to a wide
range of applications. Field measurements can be performed by:

* holding the pistol grip by hand, or
* mounting the pistol grip and other foreoptic accessories to a tripod.

Reflected radiance and surface reflectance measurements are typically made
using the hand-held configuration. The pistol grip is available with both a
sighting scope and leveling device when required for more precise
orientation.

These accessories allow viewing the exact spot where the foreoptic is pointed
and orienting the foreoptic in precise, nadir-viewing, geometry. The majority
of irradiance measurements are performed with the irradiance receptor
mounted level on a tripod because of the need for precise geometric
orientation.

Field-of-View

ASD's line of spectroradiometer is available with a wide selection of
foreoptics. These interchangeable foreoptics allow the flexibility to adapt the
FieldSpec spectroradiometer to a wide range of applications.

The small size of the FieldSpec's foreoptics allows positioning the foreoptics
at a greater distance from the surface under observation.

A field spectroradiometer with a larger field-of-view means that fewer
measurements are needed to approximate the spatial resolution of the imaging
sensor, because the pixel size of most imaging sensor systems is several
meters or more.

The small size of the pistol grip and foreoptics greatly reduce errors
associated with instrument self-shadowing. Even when the area viewed by the
foreoptic is outside the direct shadow of the spectroradiometer, the instrument
still blocks some of the illumination that would normally be striking the
surface under observation, either diffuse skylight or light scattered off
surrounding objects. Thus, the instrument as well as other objects —
including the user — should be placed as far as possible from the surface
under observation. This orientation requirement also applies to white
reference measurements.
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[P E—

Figure 4-4 Field-of-view and spot size
D == effective diameter of foreoptic lens
A == foreoptic's angular field-of-view
X
Y

distance to viewed surface
== diameter of field-of-view

Near Field (less than 1 meter):

Y=D+2*X*Tan(A/2)

Far Field (greater than 1 meter):

Y=2*X*Tan(A/2)

Table 4-1  Values of D in mm for ASD Foreoptics

FR VNIR HH

1° 44.1 17.7 8.6
2° 9.7
3° 16.5 7.0
3.5° 34
4° 5.7
7.5° 23
8° 7.9 3.7
10° 6.8 3.3 2.0
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Irradiance Observations

ASD has several types of foreoptics for irradiance measurements. These
include:
* In-air cosine corrected receptors for measurement of total irradiance

* Accessories for measurement of direct irradiance

* Under-water cosine corrected receptors for measurement of in-water up-
and down-welling irradiance.

ASD Document 600540 Rev. J 35 FieldSpec® 3 User Manual



AASDME www.asdi.com Chapter 4 Fiberoptic Interface

Notes:
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Chapter 5 Batteries

The battery specifications are:

Type: NiMH (Nickel-Metal Hydride).
Rating: 12 V 9 amp hour
Life: Over four (4) hours using a full-range FieldSpec

spectroradiometer with a Contact Probe in an ambient
environment.

Nine (9) hours using a VNIR-only FieldSpec
spectroradiometer with accessory not powered by the
instrument in an ambient environment.

i

Recycle batteries and do not dispose of as general waste.

Note:  How long the spectroradiometer will run with a fully charged battery depends
on many variables including battery age, instrument configuration,

environment, and accessories

5.1 Battery Care

powered by the accessory power port.

Proper care of the NiMH rechargeable batteries assures long life.

NiMH batteries can store 50% more power than NiCad and do not suffer from
memory effects. Unlike NiCad batteries, NIMH batteries do not use heavy
metals that may have toxic effects. Still, never drop NiMH batteries on a hard

surface.

New NiMH rechargeable batteries can last from 500 to 1000 charges.

When you receive a new battery pack, charge it fully before using it the first
time regardless of it showing full voltage and power. It can take from three (3)
to five (5) charge-and-discharge cycles before the battery pack reaches its

peak performance.

© 2010 ASD Inc.
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At normal room temperature, NiMH batteries generally lose about 1% of their
charge per day. Higher temperatures increase this loss, while lower
temperatures (40-60F) can reduce this daily loss. The daily charge loss is not a
significant factor if the batteries are used within the first five to ten days after
they have been charged.

One of the best ways to ensure that the NiMH batteries last as long as possible
is to use them often. The more they are charged and used, the longer the
NiMH batteries last.

Whether discharged or not, the NiIMH batteries should be charged at least
every sixty (60) days.

WARNING! Do not use batteries other than those supplied by ASD.
Do not use ASD batteries in a manner unauthorized by
ASD. Using improper batteries or improper use of ASD
batteries could result in bodily injury or damage to the
instrument.

5.2 Battery Charger

The battery charger specifications:

Type: External Desktop

AC Input: 90-240 VAC, 50/60 Hz

DC Input: 12VIS5A

Charge Time: under 8 hours for a fully discharged 9 AH battery

Note: Do not unplug the charger and leave the batteries in the charger. Remove the
batteries first, or they will discharge through the charger.

The battery charger is designed for indoor use and should not come in contact
with water or dust.

Review the charger instruction manual for details.

LED Status indicator:

e The LED will be ORANGE if the battery is not connected.

* The LED will be ORANGE during initialization and analysis.

e The LED will be RED during a fast charge.

¢ The LED will turn GREEN with intermittent ORANGE flash when in
top-off charge.

* The LED will be GREEN during trickle charge.
*  The LED will be alternating ORANGE-GREEN when there is an error.
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A The FieldSpec spectroradiometer will stop collecting
spectra when the battery drains to about 9.7 volts and the
software will post a “Spectrometer Isn't Ready”
message. However, the instrument and attached probe will
continue to draw current if power is left on. Power down
the instrument and remove probe as soon as possible when
the above message occurs.

5.3 Application Battery Indicator

The RS3 and Indico applications from ASD have a Power Status. It is
located at the bottom of the main window next to the

Connection Status.The voltage level of the spectrometer will be reported
in the balloon type window.

e 11-12 Volts is considered good (full).

e <11 Volts issues a warning.

x!,} Power Status

Good 124

Figure 5-1 Example of a Power Status
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Notes:
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Chapter 6 Transporting and Carrying the
FieldSpec® 3

This chapter details how the shipping case, Ergonomic Pro-Pack, and
FieldSpec spectroradiometer are designed to be used. This includes:

* Packing FieldSpec® 3 for Shipment
*  Preparing the FieldSpec® 3 and Ergonomic Pro-Pack for the Field
e Carrying Supplies

e Protecting the Instrument in the Field
6.1 Packing FieldSpec® 3 for Shipment

The Ergonomic Pro-Pack is an integral part of the padding used for the
FieldSpec spectroradiometer in the shipping case. The main reason for this is
to allow the Ergonomic Pro-Pack to be packed with the spectroradiometer, so
that both can be conveniently transported to the destination for field work
where both would be needed.

Therefore, the first steps required for preparing the FieldSpec
spectroradiometer for transport with the shipping case involve putting the
spectroradiometer into the Ergonomic Pro-Pack.
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Step 1

WARNING!

Step 2

Figure 6-1  The FieldSpec spectroradiometer in the Ergonomic
Pro-Pack with cable loosely coiled in the netting.

Coil the Fiberoptic cable loosely and place in the netting on top of the
FieldSpec spectroradiometer, as is shown in Figure 6-1.

Do not leave the Fiberoptic cable in the external spool that attaches to the
outside of the Ergonomic Pro-Pack or the battery pouches on the belt.

The fiber cable should never be stored with a bend of less
than a 5" diameter for long periods of time, because the
cable can be damaged with undetectable longitudinal
fractures that can cause light leakage and weaker signals.

Place the spectroradiometer into the Ergonomic Pro-Pack with the plastic
end-caps towards the top and bottom of the pack.

The spectroradiometer can be oriented in the Ergonomic Pro-Pack with the
Fiberoptic cable either to the right or left. Cut-outs in the shipping case lid and
floor provide room for the Fiberoptic cable for either orientation.

Note:  When facing the outside of the pack, we recommend putting the
Fiberoptic cable on the left (as shown in Figure 6-1), this puts the
cable on top when placed into the shipping case.

ASD Document 600540 Rev. J 42 FieldSpec® 3 User Manual



A‘ASDIM www.asdi.com Chapter 6 Transporting and Carrying the FieldSpec® 3

Figure 6-2  The FieldSpec spectroradiometer strapped into the
Ergonomic Pro-Pack.

Step3  Fasten the five (5) holding straps of the Ergonomic Pro-Pack to hold the
spectroradiometer in place. Two straps are on each side and one at the top.

Figure 6-3  Ergonomic Pro-Pack with the instrument controller.

Step4  Place the instrument controller into its compartment of the Ergonomic
Pro-Pack and zip up the zippers.
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Figure 6-4  Folding the left battery pouches into the Ergonomic
Pro-Pack.

Figure 6-5  Folding the right battery pouches into the Ergonomic
Pro-Pack.
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Step 5  When facing the outside of the Ergonomic Pro-Pack, fold the left battery
pouch on the pack belt in first and then the right, as is shown in Figure 6-4
through Figure 6-5.

Note: Folding the pack belt (pouches) as given in Step 5 assists sliding the
pack into the case, because there is only one orientation for placing
the Ergonomic Pro-Pack into the shipping case.

Figure 6-6  Placing the Ergonomic Pro-Pack with FieldSpec
spectroradiometer and instrument controller into the
shipping case.

Step 6  Place the Ergonomic Pro-Pack with spectroradiometer and instrument
controller into the shipping case using the handle straps at the top and the hip
belt at the bottom of the pack, as is shown in Figure 6-6.

Note: There is only one orientation for placing the Ergonomic Pro-Pack into
the shipping case. The shipping case has cut-outs intended for the
Fiberoptic cable in the floor and the lid. Therefore, the FieldSpec
spectroradiometer can be oriented in the Ergonomic Pro-Pack with
the Fiberoptic cable on either side. We recommend following these
instructions which puts the Fiberoptic cable on top when placed in the
case.
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Step 7

Figure 6-7  Shipping case with Ergonomic Pro-Pack with FieldSpec
spectroradiometer and instrument controller.

Place any accessories into the shipping case, the FieldSpec spectroradiometer,
instrument controller, and Ergonomic Pro-Pack.

6.2 Preparing the FieldSpec® 3 and Ergonomic
Pro-Pack for the Field

Note:

Step 1

Step 2

When arriving on site, unpack the FieldSpec spectroradiometer from the
shipping case, re-pack the spectroradiometer in the Ergonomic Pro-Pack
before use.

The Ergonomic Pro-Pack and FieldSpec spectroradiometer are designed for
both right-handed and left-handed use.

Think twice before orienting the FieldSpec spectroradiometer to have its
Fiberoptic cable on your dominant side in the Ergonomic Pro-Pack, because
you may want your dominant hand free for other tasks, like one-handed
typing. Generally speaking, operating the Fiberoptic accessory will probably
require less dexterity than operating the instrument controller and typing
one-handed. Taking this into consideration could affect the decision about
which side the Fiberoptic accessory will be placed on.

Follow the instructions for unpacking the FieldSpec spectroradiometer and
Ergonomic Pro-Pack from the shipping case.

Place the Ergonomic Pro-Pack on a flat surface with the shoulder straps
towards the floor.
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Step 3

Step 4

Step 5

Step 6

Step 7

Remove the instrument controller from its compartment on the outside of the
Ergonomic Pro-Pack.

Undo the five (5) plastic connectors which hold the spectroradiometer in the
Ergonomic Pro-Pack.

Determine which hand will be using the Fiberoptic accessory. Figure 6-8
shows the Fiberoptic cable on the left-hand side, because the user wanted his
right-hand free to operate the instrument controller.

Orient the spectroradiometer in the Ergonomic Pro-Pack such that the
Fiberoptic cable is on that side.

Note: The FieldSpec spectroradiometer has to have its plastic end-caps
aligned with the top and bottom of the Ergonomic Pro-Pack. Other
than this, the orientation of the spectroradiometer in the pack doesn’t
matter (e.g., cable side on left or right; mesh side close to the shoulder
straps or away)

Use the five (5) straps to secure the spectroradiometer in the pack.

Step 8

Figure 6-8  Fiberoptic cable routes to either side.

If you are using the Fiberoptic spool, determine where you want to attach it.

Figure 6-9 and Figure 6-13 show the Fiberoptic spool on the outside of the
Ergonomic Pro-Pack, where it attaches with velcro.

Figure 6-10 and Figure 6-14 show where the Fiberoptic spool attaches to one
of the battery pouches on the hip belt with metal snaps.

The Fiberoptic spool is optional and may not even be needed for short cables.
The battery pouches on the hip belt have velcro loops for holding the cable, as
is shown in Figure 6-11.
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Figure 6-9  Fiberoptic spool on the outside of the Ergonomic Pro-Pack
(with velcro).

2

Figure 6-10  Fiberoptic spool and where it attaches with snaps to the
battery pouch on the hip belt.
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Figure 6-11  Loops for the Fiberoptic cable on the battery pouch of the
hip belt.

Step9  Place the battery into the pouch on the belt on the opposite side of the
Ergonomic Pro-Pack from where the Fiberoptic cable is. Refer to Figure 6-12.

Step 10 Feed the battery cable up from the battery pouch under the cross strap to the
power input of the FieldSpec spectroradiometer, as shown in Figure 6-12.

Figure 6-12  Routing the battery cable to the FieldSpec
spectroradiometer.
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Figure 6-13  Fiberoptic cable spool on the outside of the Ergonomic
Pro-Pack.

Figure 6-14  Fiberoptic cable spool on the battery pouch on the hip belt.
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Step 11 Attach the laptop carrier to the plastic connectors on the shoulder straps of the
Ergonomic Pro-Pack, as shown in Figure 6-15.

Figure 6-15  Laptop carrier attaches to the shoulder straps of the
Ergonomic Pro-Pack.

Step 12 Place the instrument controller onto the velcro of the laptop carrier.

Step 13 The laptop carrier is equipped with a pistol grip holder.

Figure 6-16  Pistol grip holder.
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Figure 6-17  FieldSpec spectroradiometer in the Ergonomic Pro-Pack
and instrument controller on the laptop carrier.

6.3 Carrying Supplies

The Ergonomic Pro-Pack is designed for the FieldSpec spectroradiometer.
The large mesh pocket at the bottom of the pack is intended for ventilation
and to keep the instrument from overheating.

WARNING! Do not carrying clothing or other supplies in the lower
mesh pocket, particularly if they are large enough to
prevent air flow into the FieldSpec spectroradiometer.

The straps on the outside of the pack are intended for tying on clothing or
other large items.
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Figure 6-18  Allow for proper ventilation of the FieldSpec
spectroradiometer.

6.4 Protecting the Instrument in the Field

The Ergonomic Pro-Pack has a small interior pocket near its top which holds a
rain flap, as is shown in Figure 6-19 and Figure 6-20.

& The rain flap is water resistant, but not water proof.

In the event of bad weather out in the field, place the instrument controller
into its compartment on the outside of the Ergonomic Pro-Pack. Make sure
both the spectroradiometer and instrument controller are turned off. Then pull
the rain flap out of its compartment and over the outside of the pack. The
shoulder straps are still free allowing you to hike towards shelter.

Figure 6-19  Rain flap storage in the Ergonomic Pro-Pack.
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Figure 6-20  Rain flap covering the unit.

WARNING! Do not attempt to use the spectroradiometer with the rain
flap deployed. The spectroradiometer may overheat,
because the rain flap prevents adequate air from
circulating to the instrument.
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Field spectrometry is the quantitative measurement of radiance, irradiance,
reflectance or transmission in the field. It involves the collection of accurate
spectra and requires an awareness of the influences of:

*  Sources of illumination.

* Atmospheric characteristics and stability.

*  Winds.

* Instrument field-of-view.

* Sample viewing and illumination geometry.

* Instrument scanning time.

*  Spatial and temporal variability of the sample characteristics.

Many of these parameters are controlled when using one of ASD’s standard
sampling interfaces (e.g., MugLite or Contact Probe).

Spectral field measurements are desirable for many reasons, not all related to
remote sensing.

* Field spectra of ground targets on the scale of the imaging sensor using
ambient solar illumination can be used to convert radiance images to
reflectance.

* Field spectra of target materials allows for more precise image analysis
and interpretation.

* Field spectroscopy can perform feasibility studies to understand if and
how a process or material of interest can be detected using remote
sensing.

* Field spectra of both the material(s) of interest and spectra of other
materials present in the environment can be used to address:

»  What spectral and spatial resolutions are required for detection?
»  What is the best time of year/day for detection?
»  What signal-to-noise ratio is required for detection?

* Field spectra can be used to make direct material identifications in the
field rather than collecting samples for later laboratory analysis.
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The first step in the development of a field experiment is the definition of the
overall experimental design. Unfortunately, the formulation of an appropriate
experimental design is not always obvious.

Issues such as the timing of the data collection, spatial scale of the field
measurement, target viewing and illumination geometry, and the collection of
ancillary data sets must be considered in light of the objectives of the study.
The lack of appropriate ancillary data sets often makes previously collected
data sets unusable for a new application.

Frequently, the experimental design must be modified to account for the
characteristics of the available instrumentation.

For example, vegetation canopy spectra collected using a slow scanning
instrument will sometimes have small wind-induced “absorption” features in
those portions of the spectra when the instrument was viewing more shadow.

71 Illumination

In order to determine the reflectance or transmittance of a material, two
measurements are required:

* The spectral response of a reference sample.
*  The spectral response of the target material.

The reflectance or transmittance spectrum is then computed by dividing the
spectral response of the target material by that of a reference sample.

Using this method, all parameters which are multiplicative in nature and
present in both the spectral response of a reference sample and the target
material, are ratio-ed out, such as:

*  The spectral irradiance of the illumination source.
»  The optical throughput of the field spectrometer.

Note:  An inherent assumption when determining the reflectance or transmittance of
a material in the field is that the characteristics of the illumination are the
same for the reference and target materials. Variability of the illumination
characteristics between the time the reference and target materials are
measured will result in errors in the resultant spectra.

7.2 Characteristics of Natural lllumination

Field spectrometry typically involves the ambient solar illumination. As such,
the target can be illuminated by three or more sources (see Figure 7-1), each
with its own spectral characteristics. Unless the target is in a shadow, the
direct solar illumination is the dominant source of illumination.

ASD Document 600540 Rev. J 56 FieldSpec® 3 User Manual



AASDME www.asdi.com Chapter 7 Field Measurements

\\\\\ dlffuse
dle':t |IIurn|nat||:-n

|Ilum|nat||:|n

dlffuse
|IIurn|nat||:-n Ecaﬁerfrnm
Eurrnundlngs

Figure 7-1  The major sources of illumination.

Note: It is possible to have several sources of light scattered off of surrounding
objects, each with its own unique spectral distribution.

Parameters such as solar elevation angle and atmospheric conditions will
effect the overall intensity and spectral characteristics of direct solar
illumination. Diffuse skylight illumination can contribute as much as 5-10%
of the total illumination reaching a surface. At shorter wavelengths, diffuse
skylight can contribute as much as 20-25% of the total.

The spectral characteristics of the illumination scattered off of surrounding
objects is determined by their reflectance characteristics. In the case of a
forest clearing, as much as 20% of the illumination in the 750-1200 nm
wavelength range can be attributed to sunlight scattered off the surrounding
forest canopy.

One important source of surrounding scattered light is the person and the
instrumentation making the measurement. Objects in the surroundings also
effect the overall illumination of the target surface by obscuring a portion of
the diffuse skylight and, possibly, shading the target from direct solar
illumination.

The magnitude of both the diffuse skylight and scattered from surrounding
illumination components is determined by the solid angle subtended by these
sources when viewed from the reference frame of the target surface.

The surface texture of the material being measured also affects the relative
portion of the various sources of illumination. When compared to a smooth
surface, a surface with a rough texture will tend to have a higher portion of
illumination from the diffuse and scattered-from-surroundings sources
relative to the direct solar illumination.
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7.3 Characteristics of Artificial lllumination

The use of artificial illumination allows:
*  More control over illumination and viewing geometry.
*  More control over sample geometry.

*  Measurements during non-optimal conditions (e.g. cloud cover or at
night).

*  Measurement of reflectance and transmittance in the deep atmospheric
absorption bands.

Several problems with using artificial illumination include:

» Difficulty in maintaining a constant distance between the sample or
reference and the light source when measuring samples with irregular
geometry.

*  “Cooking” vegetation samples under the lights (water loss, chlorophyll
degradation).

In a typical lamp configuration for indoor use, the sample is viewed with the
collecting optics of the spectrometer nadir to the sample. Use one or two 200
to 500 Watt quartz-halogen cycle tungsten filament lamps (~3400°K color
temperature) in housings with aluminum reflectors about one meter above the
surface being measured.

Alternatively, the light source can be either incorporated into the field
spectrometer (often precluding the use of solar illumination) or can be
provided in the form of an optional accessory that mounts to the light
collecting optics of the instrument.

7.4 Atmospheric Characteristics

Absorbing molecules in the atmosphere strongly modify the incoming solar
irradiance. All of the absorption features will increase in intensity as the
atmospheric path length of the incoming solar radiation increases (e.g. with
changing solar elevation angle).

By far, water vapor is the strongest modifier of the incoming solar spectrum.
Water vapor has absorption features spanning the solar reflected region of the
spectrum (see Figure 7-2), and varies both spatially and temporally.
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Transmission spectrum of water vapor for typical
atmospheric conditions

Carbon dioxide has strong features in the 2000-2200 nm range (see

Figure 7-3), a region of major interest for the identification of layered silicate
minerals. Carbon dioxide is a well mixed gas, thus the intensity of the
absorption features associated with carbon dioxide are not as variable as those
of water vapor, but they do decrease with increasing altitude.
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Transmission spectrum of carbon dioxide for typical
atmospheric conditions.

Other major atmospheric components that influence the atmospheric
transmission spectrum are shown in Figure 7-4.
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Figure 7-4  Transmission spectrum of various gases for a typical
atmospheric conditions.

7.5 Clouds

The presence of partial cloud cover is indicative of highly spatially and
temporally variable atmospheric water vapor.

Because of the large influence of water vapor on the atmospheric transmission
(see Figure 7-2), variability of atmospheric water vapor between the time
when the reference and target measurements are made will result in errors in
the resultant spectrum.

Note:  This error can be reduced by minimizing the length of time between the
measurement of the reference sample and the target.

While they are difficult to see and often appear inconsequential, the presence
of cirrus clouds tends to educe significant variability in atmospheric water
vapor.
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Note:

In addition to the errors produced by time varying atmospheric water vapor,
partial cloud cover also greatly increases the intensity of diffuse skylight
illumination. This tends to “fill in” shadows and reduce the contrast between
surfaces with dissimilar surface textures.

If the goal is to collect field spectra for image calibration or interpretation,
spectra should be collected under illumination conditions similar to those at
the time the image was collected.

Measure the Magnitude of the Effect Cirrus Clouds

Step 1
Step 2
Step 3

Step 4

7.6 Wind

Note:

Simply standardize the field spectrometer on the reference panel.
Continue to view the reference panel with the instrument.

If the atmospheric conditions are stable, the computed reflectance of the panel
will be a flat spectrum with near 100% reflectance.

If atmospheric conditions are unstable, the computed reflectance of the panel
will vary over time and will show absorption minima or maxima (depending
on whether atmospheric water vapor is increasing or decreasing) at the
wavelengths corresponding to the water vapor absorption features.

In this way, it can be determined whether spectral data with sufficient
accuracy can be acquired.

Wind can be a source of error if the material being measured moves during
the time the spectrum is acquired.

If a spectrum is slowly scanned, changes in the amount of shadow in the
instrument field-of-view will result in erroneous “features™ in the spectrum.

Vegetation canopies, with their large portion of shadow, are especially
susceptible to wind induced errors.

Instruments using an array detector or that scan the spectrum rapidly are not
significantly affected by wind.

7.7 Vegetation

Because of the complex three dimensional geometry of a plant canopy, light
returned from the canopy is a complex mixture of multiply reflected and/or
transmitted components.

The canopy level optical signal is dependant upon:
e [llumination and viewing geometry.

*  Canopy structure.
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* Leaf optical properties.

» The optical properties of other vegetative and non-vegetative components
within and below the canopy.

Only by controlling the viewing and illumination geometry can changes be
detected in canopy reflectance. True differences in canopy reflectance
between several canopies may be due to either differences in canopy structure
or in leaf/needle optical properties.

For example, a conifer canopy will appear darker in the infrared than the
broad leaf canopy even though the reflectance of the individual needles and
leaves may be almost identical for almost all viewing geometries.

Observed differences in canopy level reflectance may be attributed to
differences in either leaf level optical properties or other, larger scale,
structural properties of the canopy. Important structural properties include:

* leaf/needle size

* leaf/needle density at the branch level

e number of years of needles retained (conifers)
* branching angles

When differences are observed between canopies of the same species, it is
almost always due to differences in canopy or branch level structure.

The absorption features seen in vegetation spectra are all related to organic
compounds common to the majority of plant species.

Thus, the information about a plant canopy is contained in the relative
intensity of the various absorption features rather than in the presence or
absence of a specific absorption feature.

The major spectral absorption features can be attributed to:
e water
* plant pigments

» chlorophyll

»  zanthophyll

» carotenoids

Other, minor, absorption features are attributable to other chemical
components; these include:

¢ cellulose

* lignin
*  proteins
» starches
* sugars
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Non-photosynthetic components of the canopy have spectra which are
dominated by absorption features attributed to lignin and cellulose.

The spectral radiance leaving a vegetation canopy is significantly impacted by
many factors, such as those listed in Table 7-1.

Table 7-1 Major variables affecting the Bidirectional Reflectance Distribution Function
(BRDF) of a vegetated canopy

[lumination *  Geometry
» angle-of-incidence of Sun (or Radar)

» azimuth

e Spectral characteristics
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Table 7-1 Major variables affecting the Bidirectional Reflectance Distribution Function
(BRDF) of a vegetated canopy

Sensor *  Canopy
» type (plant or tree nominal class)
» closure
»  orientation
»  systematic (e.g., Tows)
» unsystematic (random)
*  Crown
» shape (e.g., circular, conical)
» diameter (m)
*  Trunk or Stem
»  density (units per m2)

» tree diameter-at-breast-height: tree trunks or
plant stems have a certain density.

e Leaf

» leaf-area-index: defines the area that interacts
with solar radiation; the surface that is
responsible for carbon absorption and
exchange with the atmosphere.

» leaf-angle-distribution: may change
throughout the day as the leaves orient
themselves toward or away from the incident

radiation.
Understory same as vegetation
Soil o Texture
+ Color

¢ Moisture content

7.8 Rocks, Soils, and Man-Made Materials

The shape of the spectral signature of rocks and soil tends to be invariant with
respect to the viewing geometry, unlike vegetation. The overall brightness of
the observed spectrum does change with illumination and viewing geometry
due to changes in the amount of shadow in the field-of-view of the
spectrometer.
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Absorption features in the spectra of rocks and minerals are due to the
presence of specific molecular groups and are often diagnostic of the minerals
present in the sample.

The dependence of the optical properties of man-made objects on the viewing
and illumination geometry will fall somewhere between that for vegetation
and rocks/soils. This will depend on the amount of light transmission through
elements of the target and on the surface texture of the object.

7.9 Experimental Design

7.9.1 Time of Day / Year

The timing of the field data collection is important if field spectra are to be
used to calibrate or interpret a hyperspectral image. Reflectance spectra used
to interpret a hyperspectral image should be collected under illumination
conditions similar to those when the image was acquired.

Time of day and date are the major controlling factors of direct illumination
geometry, while atmospheric conditions relating to scattering and clouds are
the major factors controlling the geometry and relative intensity of indirect
illumination.

If field spectra are to be used to convert a hyperspectral sensor image to
reflectance, spectra should be acquired simultaneously with image
acquisition. If this is not possible, a water vapor correction should be made to
the image prior to its conversion to reflectance.

7.9.2 Sampling Strategy

The selection of a particular sampling strategy should be based upon the
objectives of the study. If the objective is to determine the detectability of
either a target material or of a process effecting the spectral signature of a
target material, the sampling strategy must encompass examples of the target
material under all expected conditions as well as all other background
materials.

Consideration must be given to all the processes modifying target and
background spectral signatures; these include illumination, slope and aspect,
and target surface architecture. Adequate collection of vegetation is even
more problematic due to the wide range of processes that effect their spectral
signature. These include soil chemical properties, soil reflectance, water
availability, time of day, time of year, cloud cover, temperature, and relative
humidity.

If the purpose of a study is to understand how a process effects the spectral
signature of a target without consideration of how background materials and
other sources of variability affect the spectral signature, variance from sources
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other than the one of interest should be minimized in the selected targets. This
is achieved by carefully controlling viewing and illumination geometry, often
in a laboratory. This type of study is often performed as a feasibility study
prior to a full study evolving collection of spectra of background material.

7.9.3 Viewing Geometry

The selection of an appropriate viewing geometry depends upon whether the
spectra are used for image analysis or for a feasibility study.

Image analysis: a viewing geometry similar to the airborne sensor is
required.

Feasibility study: it is possible to eliminate much of the confounding
variance typically present in an image data set by fixing the viewing and
illumination geometry.

For vegetation, spectra can be acquired at the spatial scale of the leaf/needle,
branch, or canopy. Canopy level spectra are most suitable for image analysis
and interpretation. Rarely can leaf/needle or branch level spectra be used
directly to interpret an image. Leaf/needle and branch level spectra are useful
to understand how the canopy level spectra are influenced by changes in
leaf/needle and branch spectral changes as opposed to changes in the canopy
structure.

7.10 Suggested Set-up

7.10.1 RS3 Application

Step 1

Step 2
Step 3

Step 4

Note:

Step 5

Follow the instructions for plugging in the instrument and starting the RS3
software.

Attach any required foreoptic accessories.

Open the pull down menu Control -> Adjust Configuration [Alt+C,C] in
the RS3 application.

Set the white reference number of scans to 30, and dark current averages to 60
scans.

The actual spectrum average will be determined by striking a compromise
between noise reduction through averaging the spectra and the time desired
for each spectrum collection. For instance, if you are using the instrument in
the field, are walking a large area, and are making frequent spectral readings,
you will want a shorter average setting than if you are collecting spectra
in-situ and desire the cleanest spectra possible.

Optimize the instrument to the Spectralon.
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Step 6
Step 7

Spectralon is an example of a reference standard to take a white reference
against. (Labsphere, Inc., Shaker St., PO Box 70, North Sutton, NH
03260-0070, PH: 603-927-4266, FX: 603-927-4694, E-mail:
sales@labsphere.com, Website: www.labsphere.com). Spectralon is also
available from ASD.

Take a White Reference (or baseline reference).

Observe samples.

7.10.2 Indico Application

Step 1

Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

Step 8

Step 9

Follow the instructions for plugging in the instrument and starting the Indico
software.

Attach any required foreoptic accessories.

Open a new project either by selecting File->New Project from the
pull-down menu.

Type in a name for this project and click on the OK button.
Select Spectrum->Sample Count/Average from the pull-down menu.

Set the Instrument Sample Count to 100 for outdoor solar illumination
and click OK.

Note: The actual spectrum average will be determined by striking a
compromise between noise reduction through averaging the spectra
and the time desired for each spectrum collection. For instance, if you
are using the instrument in the field, are walking a large area, and are
making frequent spectral readings, you will want a shorter average
setting than if you are collecting spectra in-situ and desire the cleanest
spectra possible.

The project screen will return, and the sample count will be displayed in the
status box at the bottom of the graph.

Make sure the light source is on and the probe input end is pointed at the
white reference panel.

Select Spectrum->Take a Baseline [Alt+S, B] [CtrI+R]. When
prompted, click Yes, take a new white reference.

*  The FieldSpec spectroradiometer optimizes the detector sensitivities for
the probe and light source currently being used.

¢ The dark offset and white reference will also be measured and saved.
»  Status bars will indicate each process.

When optimization and white reference are complete, you should see a
straight baseline across the Project Graph at 1.00 (100%).

Select the Display->Reflectance [Alt+D, R] for the reflectance mode.
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Step 10 Place the sample on the white reference panel and the spacer end in contact

against the sample.

This assumes that your reflectance probe has appropriate spacing or spacers
on the end.

Press the Space Bar once or select the Spectrum->Take a Scan [Alt+S,
Tl

When the FieldSpec spectroradiometer finishes recording and averaging the
Spectra, the graph in the project window will be updated to show the

Step 11

reflectance spectrum of the sample.

Step 12 Observe samples.
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7.11 White Reference

A material with 95-99% reflectance across the entire spectrum is called a
white reference panel or white reference standard.

The raw measurement made by the spectroradiometer is influenced by both
the sample and the light source. An independent measure of the light source
illumination on a reference of known reflectance is required to calculate the
reflectance of the sample. The use of a white reference standard with near
100% reflectance simplifies this calculation.

The ASD application software, such as RS3 and Indico, can calculate the
ratios for reflectance or transmittance of the material being sampled by the
FieldSpec spectroradiometer using the white reference as the standard.

Spectralon from Labsphere is the white reference standard that is very
suitable for the VNIR and SWIR spectral ranges of ASD instruments.

Spectralon is made of polytetraflouroethylene (PTFE) and cintered halon. It
has the characteristic of being nearly 100% reflective within the wavelength
range of 350 nm to 2500 nm. A Spectralon white reference scatters light
uniformly in all directions within that wavelength range.

7.11.1 Spectralon Reflectance Data

Table 7-2 shows the published reflectance data for an uncalibrated SRM-990.
When SRM-990 is used as the white reference for a reflectance measurement
with the FieldSpec spectroradiometer, an even closer reflectance value for the
sample can be calculated.

Table 7-2Labsphere's published reflectance data for uncalibrated Spectralon (+/- 0.5%)

SRM-990 “Uncalibrated”
Wavelength (nm) Spectralon Reflectance
250 0.950
300 0.985
400 0.990
500 0.991
600 0.992
700 0.992
800 0.991
900 0.991
1000 0.993
1100 0.993
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Table 7-2Labsphere's published reflectance data for uncalibrated Spectralon (+/- 0.5%)

SRM-990 “Uncalibrated”
Wavelength (nm) Spectralon Reflectance
1200 0.992
1300 0.992
1400 0.991
1500 0.991
1600 0.991
1700 0.988
1800 0.989
1900 0.981
2000 0.976
2100 0.953
2200 0.973
2300 0.972
2400 0.955
2500 0.950

Reflectance = Energy reflected from target/energy incident on target
7.11.2 Maintaining Spectralon References

Spectralon is an optical standard and should be handled in much the same way
as other optical standards. Although the material is very durable, care should
be taken to prevent contaminants such as finger oils from contacting the
material’s surface. Always wear clean gloves when handling Spectralon.

To clean a lightly soiled Spectralon white reference

If the material is lightly soiled, it may be air brushed with a jet of clean dry air
or nitrogen.

WARNING! DO NOT use Freon.

To clean a heavily soiled Spectralon white reference

Sand the Spectralon material under running water with a 220-240 grit
waterproof emery cloth or sandpaper until the surface is totally hydrophobic
(water beads and runs off immediately).

Step 1  Use a flat surface, such as a thick, flat piece of glass.
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Step 2
Step 3
Step 4

Step 5
Step 6

WARNING!

Place the glass into the sink.
Place 220 grade wet sandpaper onto the glass.

Gently move the Spectralon reference in a figure 8 motion on the sandpaper,
using water as needed to wash away the thin layer that is sanded off.

Blow dry with clean air or nitrogen or allow the material to air dry.

If the material requires high resistance to deep UV radiation, the piece should
be prepared as above, then either of the following two treatments performed.

1 Flush the Spectralon piece with >18 milli-ohm distilled, deionized water
for 24 hours.

2 Vacuum bake the Spectralon piece at 75° C for a 12 hour period at a
vacuum of 1 Torr or less. Then purge the vacuum oven with clean dry air
or nitrogen.

Do not use oils or soaps to clean the Spectralon white

reference.

7.11.3 White Reference Procedures

Note:

Note:

White references should be collected approximately every 15 minutes and can
be varied depending on whether conditions are changing rapidly or not
changing very much. The Spectralon puck should be used when optimizing
and taking a white reference measurement.

For best results, the Spectralon puck should be at the same distance and angle
from the foreoptic as the sample will be during measurements.

When saving reflectance data, point the probe at the Spectralon with the same
viewing geometry for a minute or two every few measurements. If the relative
reflectance of the Spectralon is less than or greater than one, a new white
reference may be needed. If the relative reflectance of the Spectralon is
greater than one, re-optimization is recommended.

The FieldSpec spectroradiometer should be re-optimized for:
* Light changes.

* Any atmospheric changes.

* Temperature changes.

*  Whenever accessory probes are changed.

Environmental conditions can change rapidly or slowly. It all depends on
clouds, wind (affecting temperature), instrument warm up time, etc.

ASD Document 600540 Rev. J 71 FieldSpec® 3 User Manual



AASDME www.asdi.com Chapter 7 Field Measurements

Notes:
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Appendix A Troubleshooting

A.1 Common Communication Fixes

To fix many communication errors (particularly if the instrument has been
functioning at some point), power cycle the instrument and/or the instrument
controller.

The sequence to use will vary depending on the computer manufacturer.
Either:

e Leave the computer on. Turn off the instrument. Wait for 10 seconds.
Turn the instrument back on.

*  Or, turn off the computer and the instrument. Turn on the instrument.
Then turn on the instrument controller.

If attempting to communicate by wireless mode, make sure the wireless radio
(“airplane mode”) switch is turned on.

If you receive a 400 command error while attempting to start the RS3
software, you will need to reload the instrument ini file to the instrument. Use
the Netconfig utility to do this. A video tutorial is available from the support
website that describes this procedure. The website is at
http://support.asdi.com. Go to the Downloads page and then to the FieldSpec
3 page and to the tutorial section.

For the best performance, you should assure a clear line-of-sight between the
spectroradiometer and instrument controller. Obstructions or radio frequency
interference in close proximity can cause loss of communication or
significantly shorten the communication range.

The FieldSpec spectroradiometer uses industry standard components. You
should see the same general connection speed and distance capabilities as
other wireless devices.

A.2 Does Not Connect to the Spectrometer

» Refer to section A.1, Common Communication Fixes.
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e Check that the Ethernet cable is securely inserted into the spectrometer
and host computer. Check that the Ethernet LED is on.

* For an isolated network, check that the Ethernet cable is a cross-over
Ethernet cable.

e For an established network, check that the Ethernet cable is a standard
Ethernet cable.

*  Check that the IP Address is in the same range or subnet as the ASD
spectrometer. The same subnet means that the first three octets of the IP
address (xxx.xxx.xxX.___ ) match the spectrometer and the computer.

* Do a ping test to make sure the spectrometer is responding.
» Open up a command window by select Start->Run
» Type cmd in the Run window.
» Select OK to open the window.
»  For an Ethernet connection, type: ping 10.1.1.11

» For a wireless connection, type: ping 10.1.1.77

- Tvpe the name of a program, Folder, document, or
E Internet resource, and Windows will open it For wou,

Open: | v|

[ Ok, ][ Cancel ][ Browse... ]

Figure A-1 Run window with cmd.
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CAWINDOWS\system 3 2\cmd. exe

Microsoft Windows XP [Uersion 5.1.26081
CC>» Copyright 1985-2081 Microzoft Corp.

C=“Documents and Settings“Bryon’ping 1@

Pinging 18.1.1.11 with 32 hutes of data:

18.1.1.11: bytes=32 time<ims TTL=6@
18.1.1.11: byte==32 timedims= TTL=68
18.1.1.11: hytes=32 time<ims TTL=68
Heply from 18.1.1.11: bytes=32 time<ims TTL=06@

Ping statistics for 1@8.1_.1_.11:

Packets: Sent = 4, Received = 4, Lost = B (B: loss).
Approximate round trip times in milli-—seconds:

Minimum = Bmz,. Maximum = @Gms, Average = Bms

C=“Documents and Settings“Bruvon>_

Figure A-2 Successful result of a ping operation.

The default IP Address for the ASD spectrometer is:
« 10.1.1.11 for the Ethernet interface, or

* 10.1.1.77 for the wireless interface.

The default subnet mask is 255.255.255.0.

The computer's Ethernet adapter or wireless adapter must have a unique IP
address in the same range as the spectrometer, such as 10.1.1.X where X is a
unique number. The subnet mask must also be the same as the spectrometer.

such as 255.255.255.0.

A.3 Does Not Connect Wireless

e Refer to section A.1, Common Communication Fixes.

*  Check to make sure the wireless adapter is in the same range as the ASD
spectrometer.

The default IP Address for the ASD spectrometer is:
» 10.1.1.11 for the Ethernet interface, or
» 10.1.1.77 for the wireless interface.

The default subnet mask is 255.255.255.0.
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The computer's Ethernet adapter or wireless adapter must have a unique
IP address in the same range as the spectrometer, such as 10.1.1.x where
X is a unique number. The subnet mask must also be the same as the
spectrometer. such as 255.255.255.0.

*  Check to make sure the wireless adapter is connected to the spectrometer.
(For Windows XP)

»

»

»

»

»

»

Select Start->Network Connections.
Right click on the wireless adapter.
Select View Available Wireless Networks.

Make sure the ASD spectrometer shows up in the list of wireless
networks. If the spectrometer is not connected,

»  Select the spectrometer.
» Select the Connect button.

If you are using encryption, then make sure you are using the same
WEP key in the wireless adapter as the ASD spectrometer.

Power cycle the spectrometer.
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1 Wireless Metwork Connection X
Network Tasks Choose a wireless network
g Refresh network, list Click an item in the list below to connect o a wireless netwark in range or ko get maore
information,
< Set up a wirsless network (t@)) Colorlink
for a hiome or small office
5 Security-enabled wireless network Im]'][l
Related Tasks % 2001 wifi
L Learn about wireless Q " Security-enabled computer-ta-computer netwark IIIII
networking
Change the order of
preferred nebworks
“Ju Change advanced
settings
Conneck

Figure A-3 Wireless Network Connection.

A.4 Does Not Connect to the Access Point

e Refer to section A.1, Common Communication Fixes.

*  Check to make sure the wireless interface on the spectrometer is not set to
ad hoc.

*  Check to make sure the SSID of the spectrometer is the same as the
access point.

» Ifyou are using encryption, then make sure you are using the same WEP
key in the spectrometer as the access point.

*  Move the access point, spectrometer, and instrument controller
(computer) to the same room to test the connection.
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A.5 Spectrometer Loses its Wireless Connection

¢ Refer to section A.1, Common Communication Fixes.

*  Try to minimize the RF noise in your environment. RF noise interference
can come from: 2.4 Ghz cordless phones, microwaves, monitors, electric
motors, ceiling fan, lights, security systems, etc.

*  Positioning of the spectrometer and instrument controller (computer) can
affect the wireless range. Minimize obstructions between the
spectrometer and the instrument controller. Wall, ceilings, doors,
buildings, hills, etc. can degrade the signal of the spectrometer and
computer.

A.6 Wireless Interface is Disabled in the Netcfg
Application

* Refer to section A.1, Common Communication Fixes.

e Check to make sure the wireless adapter is in the same range as the
spectrometer.

The default IP Address for the ASD spectrometer is:
» 10.1.1.11 for the Ethernet interface, or

» 10.1.1.77 for the wireless interface.

The default subnet mask is 255.255.255.0.

The computer's Ethernet adapter or wireless adapter must have a unique
IP address in the same range as the spectrometer, such as 10.1.1.x where
X is a unique number. The subnet mask must also be the same as the
spectrometer, such as 255.255.255.0.

*  Unplug the Ethernet cable from the spectrometer.
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Notes:
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Appendix B Reference Information

B.1 Frequently Asked Questions (FAQ)

B.1.1  What is a spectroradiometer?

Spectrograph - An optical instrument for forming the spectrum of a light
source and recording it on a film. The dispersing medium may be a prism or a
diffraction grating. This term was common prior to the digital age. ASD
instruments do not use film.

Spectrometer - An optical instrument which uses detectors other than
photographic film to measure the distribution of radiation in a particular
wavelength region. All ASD instruments are spectrometers.

Spectroradiometer - An optical instrument for measuring the radiant energy
(radiance or irradiance) from a source at each wavelength throughout the
spectrum. A spectroradiometer is a special kind of spectrometer.

Note:  Only the FieldSpec spectrometer is configured as a
spectroradiometer. The reason is that the fiberoptic cable significantly
affects the calibration required to measure radiance. The FieldSpec
instrument has a fixed fiberoptic cable routed directly through the
front panel to the internal spectrometers, while the other ASD
spectrometers are designed to detach and even interchange fiberoptic
cables. To be meaningful, radiance measurements with
non-FieldSpec instruments would have to be performed using the
same fiberoptic cable and the same connector orientation of
the plugged in fiberoptic cable as the factory calibration.

The SWIR component of the ASD spectrometer is a scanning spectrometer,
while the VNIR component is an array spectrometer.
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B.1.2 What are the differences between the ASD
spectrometers?

FieldSpec - is a general-purpose spectrometer specifically designed for field
environmental remote sensing. The FieldSpec is a spectroradiometer in
that it is calibrated to be able to perform radiance and irradiance
measurements, as well as reflectance and transmittance. The fiberoptic
cable is routed through the front panel and is fixed to the internal
spectrometers, which provides a superior signal-to-noise ratio than the
other ASD spectrometers with detachable fiberoptic cables. (The
FieldSpec spectrometer can also be specially ordered as a high-resolution
instrument, the main TerraSpec feature.)

TerraSpec - is a high-resolution spectrometer specially designed for mining
and geology applications. It is ideally suited for performing reflectance
spectral measurements of rocks, minerals, and core samples. Its higher
resolution is optimized for samples that have high absorption features.
The Hi-Brite MugLite and Hi-Brite Contact Probe are designed to work
with this spectrometer.

AgriSpec - is a general-purpose spectrometer designed for agriculture and the
field analysis of vegetation and soils. Its resolution is ideally suited for
performing reflectance and transmittance spectral measurements of
samples that have broad absorptions features. This spectrometer can use
nearly all of the accessories containing a light source, such as the plant
probe and leaf clip.

LabSpec - is a general-purpose spectrometer designed not only for laboratory
analysis, but also for the plant floor, receiving, and even field work. It is
meant to be portable for multiple uses requiring visible and near infrared
reflectance, transmission, or absorbance to analyze and identify materials.
The LabSpec is similar to the AgriSpec. The LabSpec 2500 has a 10 nm
resolution, while the LabSpec 2600 has a 6 nm resolution.

QualitySpec - is a general-purpose spectrometer specifically designed for
material analysis and identification in the laboratory. The QualitySpec
features are equivalent to the AgriSpec except that it is not field-portable.

B.1.3 What is remote sensing?

Remote sensing is defined as the art and science of obtaining information
about an object without being in direct physical contact with the object.

The ASD spectrometers achieve this using visible near-infrared (VNIR) and
short-wave infrared (SWIR) spectra.
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B.1.4 How often do I need to optimize?

Optimization has no affect on the data unless the measurement has drifted
towards saturation, in which case optimization is mandatory. The RS3
application provides a saturation warning.

B.1.5 How often do I need a (baseline) White Reference?

Inside Use or Constant Lighting Conditions

When using the instrument inside under constant lighting conditions or when
using an accessory with its own light source, collect a (baseline) white
reference every 10 to 15 minutes while the instrument is warming up and then
every 30 minutes thereafter.

Outside Use
When using the instrument outside, you should collect a new white reference
frequently for:

» solar changes, like the sun’s angle in the sky where 10 minutes can
represent a change in the measurement;

» atmospheric changes, like blue sky, cloud cover, humidity, or water vapor
* temperature changes
» accessory changes (like switching probes)

It is important that the light intensity is the same for when the white reference
is collected as for the measurements of the sample.

An experiment to perform when outside is to continue to take measurements
of the white reference panel and observe the stability of the white reference
line. This will give you an idea of how the current fluctuations in weather
affect your measurements.

B.1.6 What spectrum average (or sample count) should | use?

When outside, it is usually sufficient to use 30 scans in the spectrum
averaging for the sample and 60 scans for the white reference. The white
reference isn’t taken as often, which is why you would want to include more
scans in its averaging.
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The signal-to-noise measurement increases with the square root of the number
of scans used in the averaging.

Note:  The actual spectrum average will be a compromise between noise reduction
through spectra averaging and the time required for each spectra collection.
For instance, if you are using the instrument in the field to measure a large
number of samples, you will want a smaller number of spectra in the average
to decrease the collection time required. If you are collecting spectra in the
lab, you’ll want to increase the number of spectra in the averaging to obtain
the cleanest spectra possible.

B.1.7 What if | want to keep the same settings all day?

Even if you could keep the same settings for the integration time, gain value,
and offset value for the entire day, you probably wouldn’t want to.

Most of the measurements made by the instrument are ratios where such
values get cancelled out and become irrelevant.

It is far more important to keep the instrument from saturation and to ensure
the (baseline) white reference is fresh.

B.1.8 When do | use absolute reflectance?

It depends on how you are analyzing your data. An absolute reflectance most
likely will not be needed when using an accessory with its own light source.

It can’t hurt to use absolute reflectance. The difference between absolute and
relative reflectance is small for wavelengths less than 2000 nm.

Because relative reflectance relies on a physical (Spectralon) white reference,
you will see detect deviations from the absolute below 350-400 nm and above
2000-2500 nm.

B.1.9 How do I know the field-of-view that I’'m using?

The field-of-view is labeled on the foreoptic that you use. The bare fiber has a
25 degree field-of-view.

When you are measuring radiance, it is important that the RS3 application
software is using the correct field-of-view setting.
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[ —

Figure B-1  Field-of-view

effective diameter of foreoptic lens
foreoptic's angular field-of-view
distance to viewed surface
diameter of field-of-view

<X >» 0
I
I

Near Field (less than 1 meter):

Y=D+2*X*Tan(A/2)

Far Field (greater than 1 meter):

Y =2*X*Tan(A/2)

B.1.10 What are the units of radiance?

Radiance is the radiant power per unit source area per unit solid angle. This is
measured in Watts per square meter per steradian (W/m?2/sr).

However, the FieldSpec spectroradiometer measures spectral radiance, which
is the amount of radiance per unit wavelength. Spectral radiance is measured
in Watts per square meter per steradian per nanometer (W/m?2/sr/nm).

Reflectance and transmission measurements are ratios of the optical energy
from a sample compared to the optical energy from a reference panel. The
units cancel out, so these measurements do not use the calibration files to
calculate radiance.
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B.1.11 Can I post-process my data?

Yes. ViewSpec is one of many applications that can post-process your data.
Various software packages are available for chemometric model. The spectral
data can be imported into many different applications.

The complete specification of the ASD file format is available upon request.
B.1.12 Why do | see oscillations (sine wave) in my data?

Your light source may use AC power. A single SWIR band is about 100 ms. If
you observe five (5) or six (6) waves in a single SWIR, the AC light source is
the cause.

Waves can also occur if the lamp reflector and/or cover glass behave as a
white-light interferometer. Solution: remove the glass and/or use a more
diffuse reflector.

B.1.13 What are these two large noise bands in my data?

Water vapor in the atmosphere absorbs light in the 1400 nm and 1800 nm
bands.

-----------------------------------------------------------------------------------------------------

____________________________________________________________________________________________________

500 750 1000 1250 1500 1750 2000 2250 2500
Wavelength

Figure B-2  Examples of water vapor absorbing light.

ASD Document 600540 Rev. J 84 FieldSpec® 3 User Manual



A ASDME www.asdi.com Appendix B Reference Information

B.1.14 What are these upward or downward spikes in VNIR

data?

. ViewSpec Pro Graph

These result from artificial light sources, in particular fluorescent lights.

Print  Export  Title  SubTitle

Flourescent Light

[NR=NE

[NR= 2

Reflectance

D-D.Illllll

i I - A
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1000 1250 1500 1750 2000 2280 2500
Wavelength

Figure B-3  Spectrum of fluorescent lights

B.1.15 What are these steps in my data?

Light is brought into the instrument by various combinations of the strands in
the fiberoptic cable. Each strand has its own field-of-view (FOV). When the
cable is held close to the sample, each strand views slightly different portions
of the sample. This can result in the stepped data.

Hold the end of the fiber cable further away from the sample to allow the
FOV of the individual strands to overlap and mesh together.

Stepping of data is common when the foreoptic has a lens, and less common
when using the bare optics or sampling devices.
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B.1.16 What can cause more noise in my data from last time?

Many factors can cause noise in your data from one session to another. Noise
in a measurement is related to the instrument, the signal level, and noise in the
light source. Many times the appearance of noise is actually a decrease in the
strength of the signal, as opposed to an increase in noise.

Under normal operating conditions, noise visible in a spectrum is always the
result of a trade-off between the inherent noise in the system and the signal.

The angle of the sun at high noon in the Fall has a reduced light level than at
high noon in high summer. Likewise, the time of day and the sun’s position
affects light levels, as well as atmospheric conditions.

Also, broken fibers in the fiberoptic cable can contribute to noise. Perform a
fiberoptic check to verify.

An increase in noise can be due to a problem in the instrument such as an
electronic component malfunction or a grounding problem. This will many
times be indicated by a regular pattern to the noise or periodic bursts of noise
that are visible over the normal spectra.

B.1.17 Why does the VNIR drop to zero after a Dark Current
collection?

When the VNIR drops to zero after a Dark Current has been collected, this
may indicate a problem with the VNIR shutter or Dark Current collection
routine. To verify, optimize the instrument and listen for the click of the
shutter activating. If you do not hear the shutter click, contact technical
support and obtain an RMA for sending the instrument in for repairs.

B.1.18 How do I collect a reference with a spot size larger than
the Spectralon panel?

Purchase a bigger reference panel or move the sampling accessory closer to it.

If you are indoors using artificial light, make sure that the distance and angle
from the reference is the same as will be used for the sample.

If you are outdoors and the sun is your light source, it is okay if your reference
panel is closer to the foreoptics and the sample is farther away.

B.1.19 How do | set up GPS?

The GPS feature is enabled in the RS3 application software.
To configure the GPS:

Step1  Select either:
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Step 2

Step 3

Step 4

Step 5

* GPS->Settings... pull-down menu item.
+ AIt+G, S key combination.

RS3 requires the output of the GPS device to be in the National Marine
Electronics Association (NMEA) format. Check your GPS device
documentation for output and port settings.

Normally, the Baud rate (4800), Data bits (8), Parity (none), and Stop bits (1)
settings will remain the same as what is displayed in the window. The Write
to log file is checked by default. When this field is checked and the GPS
fixed data is enabled, an entry will be made to a daily log file (i.e.
050302gps.log) when a spectrum is saved.

In the GPS Settings dialog box, enter communication settings appropriate
for your instrument controller’s port intended for use as well as the GPS
device.

Note:  The RS3 settings on the instrument controller and the ports that are
used must match the actual port used as well as the settings of the
GPS device.

Connect an appropriate cable between the instrument controller’s port and the
GPS device.

You may need a serial-USB converter depending upon the instrument
controller and GPS device.

Enable the GPS functionality in the RS3 application by selecting either:
* GPS->Enable... pull-down menu item.
+ AIt+G, E key combination.

Refer to the manual of your actual GPS device for further instructions
regarding usage and configuration.

B.1.20 What does a broken fiber mean?

The fiber-optic cable is made up of fifty-seven (57) randomly distributed glass
fibers.

* 19 fibers are 100 micron for the VNIR region.
* 19 fibers are 200 micron for the SWIR1 region.
* 19 fibers are 200 micron for the SWIR2 region.

Therefore, a single broken fiber results in a ~5% reduction in the signal in a
given region.

Therefore, a single broken fiber in the internal cable results in a ~5%
reduction in the signal in a given region.
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A few broken fibers is not critical when measuring reflectance, because this is
a ratio. Any noise introduced by the broken fibers in measuring the sample
were also present when measuring the white reference, and therefore cancels
out.

Radiance and irradiance are measured using the raw data and comparing to
numbers that exist in the calibration file. Therefore, a few broken fibers will
result in lower values.

The fibers are protected by a metal spiral inside the black cable casing. If
there are kinks in your cable, the fibers are not necessarily damaged.
However, if your cable has been crunched so severely that you are able to see
the protective metal spiral, the chances are high that the fibers have been
damaged too. Refer to the fiberoptic Check utility to determine if any fibers
are broken.

The fibers can be damaged by coiling the cable up too tightly. If left in a tight
coil for longer than a week, the fibers are likely to develop longitudinal
fractures that will not be detectable. These fractures in the fiber will cause
light leakage, resulting in a weaker signal. The fiberoptic cables should be
stored by placing them loosely within the netting compartment on the
instrument.

WARNING! The fiber cable should never be stored with a bend of less
than a 5" diameter for long periods of time.

B.1.21 How long is the battery life?

The charge of the NiIMH (Nickel-Metal Hydride) battery lasts about nine (9)
hours using a VNIR-only spectroradiometer with accessory not powered by

the instrument in an ambient environment. The charge of the NiMH battery

lasts over four (4) hours using a full-range spectroradiometer with a Contact
Probe in an ambient environment.

The Gel Cell rechargeable battery lasts about nine (9) hours using a
VNIR-only spectroradiometer with accessory not powered by the instrument
in an ambient environment. The charge of the Gel Cell battery lasts over four
(4) hours using a full-range spectroradiometer with a Contact Probe in an
ambient environment.

The Gel Cell rechargeable batteries are rated to give 200 to 300 uses when
they are fully drained (discharged to 9 volts) each use. Letting the battery
discharge under 9 Volts will shorten the battery's life. If the battery is only
used for 50% rated capacity up to 500 uses are possible. In the same way
using only 30% capacity can result in up to 1,000 uses.

Note:  The limiting factor for how long you can work in the field may be the battery
in the instrument controller rather than the spectroradiometer’s batteries.
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B.1.22 What type of Ethernet cable can | use for the static IP
configuration?

The spectrometer can be plugged directly into the instrument controller using
a cross-over, shielded Ethernet cable.

When the spectrometer and instrument controller communicate over a
network, use standard shielded Ethernet cables and IP addresses compatible
with the network. The spectrometer imposes significant traffic on the
network, which can cause packet delays to other users. More importantly,
network traffic from other users can negatively impact the reliability of the
communication between spectrometer and instrument controller.

B.1.23 Can Il install additional software on the instrument
controller?

Yes, but with qualifications.

The types of applications that can interfere with the measurement of data are
utility programs, network programs, and those working in the background,
such as virus checkers.

ASD programs, such as RS3 and Indico, require real-time access to the data
that is being streamed from the FieldSpec spectroradiometer at a high rate of
speed. Programs running in the background can cause packets to be lost.

Microsoft Office, image processing programs, and other software applications
generally do not interfere with ASD programs, particularly if they are not
running and competing for CPU cycles and RAM at the same time that data is
being collected from the FieldSpec spectroradiometer.

B.1.24 Why does the software seem to do unexpected things?

To assure accuracy in the collection and processing of data, the ASD
application software is designed to finish its current operation before moving
on. The FieldSpec spectroradiometer outputs a lot of data at a high rate of
speed for the ASD application software to collect.

In addition, the ASD application software will stack up your keystroke entries
and execute them later in the order they were received.

It is important that you wait for the collection to finish before entering the
commands to launch another operation. Don’t rush into new operations or into
issuing new commands until you see the results of the current command.
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B.1.25 How long does it take for the FieldSpec
spectroradiometer to warm up?

The warm-up time of the instrument depends on the environment in which it
is used.

One hour is recommended for radiometric work.

Only 15 minutes is needed for reflectance measurements, particularly if
conserving battery life is desirable.

B.1.26 Where is my serial number?

The serial number is a five (5) digit number located on a label on the rear of
the FieldSpec spectroradiometer where the power switch is. The label also
contains the model number and MAC address for the spectroradiometer.

fve, Swuite A Boulder, Colorado 80301 LUSA |
AR SRS Fees raans tom Vesh wes R o

iI-E; VICES. |l:'l": a \
A |
: A100700 ]
12001

MSwwss| Al-00-01-F1-11-11

Figure B-4  Label with serial number.

The serial number is also accessible in the RS3 and Indico applications from
the splash screen or the Help->About menu item.

B.2 Data Conversion

When using the RS3 application, ViewSpec can convert spectral data to
ASCII text files.

Conversion can be done one file at a time. Or, several files can be merged into
a single text file, which is a useful feature when inputting data into other
analysis programs.

B.3 Gain and Offset

Gains and offsets are determined during optimization by an optimization
algorithm in the RS3 application. You can observe this process in the RS3
application by depressing the OP button on the top right-hand toolbar. The
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gains, offsets, and integration time will then appear in the lower left hand
corner. These parameters are set by the optimization routine and cannot be set
manually.

The Gain Value is the inverse of actual gain. A decrease in Gain Value will
produce a higher gain. The maximum Gain Value is 16. Under the low light
levels that create such a gain, small changes in Offset will translate into large
changes in dynamic range.

Offset causes a downward shift (from Y=32,768 DN) in a SWIR spectrum
such that the max value of the spectrum and the minimum value of the
spectrum (Dark Current - off screen) are equidistant from the line y=32,768.
Under ideal conditions, where there's enough light, there will be about 32,768
DN of signal immediately after optimization, +/- 1,000. This means that
optimization “creates” about 16,000 DN of dark current and about 16,000 DN
of dynamic range. But this dynamic range will disappear with either a slight
increase in signal (if the signal started out low to begin with) or a slight
increase in dark current (increases with ambient temperature).

B.4 Light Source

When using ASD's ProLamp illumination source, the less intense the lamp
setting (knob on side of light source), the more diffuse (homogeneous) it will
be. An average spot size of reasonable homogeneity is about 10 cm at a 50 cm
lamp distance. Two lamps improve this geometry significantly, especially for
large targets. If lighting conditions are so poor that you are continually
re-optimizing, try optimizing with a brighter source:

*  For outdoor optimization, tilt the Spectralon® panel directly towards the
sun during optimization.

* For enclosed illumination of targets requiring contact measurements, we
recommend ASD's High Intensity Reflectance probe.

*  Under low light conditions, consider using a reference panel < 99-100%
white and then post-process out the difference between the white and gray
reference in ViewSpec.

B.5 Optimization

The FieldSpec spectroradiometer must be re-optimized for:
* Light changes.

* Any atmospheric changes.

e Outdoor solar changes at least every 10 to 15 minutes.

* Indoor use every 30 minutes.
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¢ Changes in temperature.

Note:  Conditions can change rapidly or slowly. It all depends on clouds, wind
(affecting temperature), instrument warm up time, etc.

Optimization depends on the response to light in a particular spectral region.
A well-optimized instrument will display between 20,000 and 35,000 raw
digital numbers, if the source is within the gain and integration time abilities
of the system. The magnitude of the VNIR raw DN will be directly dependent
on the light intensity.

The Spectralon blank should be used when optimizing and for taking a white
reference measurement.

Note: It is important that the position of the reference sample when taking a white
reference is as similar as possible to the position for capturing data from the
samples.

When saving reflectance data, point the probe at the Spectralon once every
few measurements for a minute or two with the same viewing geometry. If the
relative reflectance of the Spectralon is less than or greater than one, a new
white reference may be needed. If the relative reflectance of the Spectralon is
greater than one, re-optimization is recommended.

B.6 Spectral Discontinuities

Three separate detectors are used to collect data over the complete spectral
range; therefore spectral discontinuities should be expected at 1000 nm and
1830 nm when operating in raw DN mode. These discontinuities decrease in
the reflectance mode when the ratio of the raw DN file to the calibration file
(a white reference or a radiometric calibration response to a calibrated light
field) is calculated because both files will contain the same discontinuities in
the data.

Excessive discontinuities in radiometric spectra can be caused by not
allowing the instrument to warm up fully. Normal discontinuities can be
addressed by using the parabolic correction utility.

B.6.1 Field-of-View

The VNIR spectrometer/fiber bundle has a slightly broader field-of-view than
the SWIR spectrometers. Discontinuities in reflectance data may be caused by
shading differences in the VNIR data as opposed to the SWIR data.

Steps at the spectrometer splices are most commonly associated with
measurements of surfaces with very patchy brightness. The steps result from
the different spectrometers viewing slightly different areas on the sample. The
steps are seen when these three areas (VNIR, SWIR1 & SWIR?2) have
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differing reflectance values at the crossover wavelengths. Averaging several
measurements of slightly different areas on the ground will minimize the
steps.

B.6.2 White Reference

White references should be collected at least every 10 minutes under typical
atmospheric conditions. The frequency of white reference collect should be
increased for less stable atmospheric conditions. The “flatness” of the
reflectance of the reference panel when observed as a sample can be used to
judge changes in the atmospheric conditions from when the white reference
was originally collected.

As the instrument warms up, the sensitivity at the red end of the VNIR array
will increase while that at the blue end of SWIR2 will decrease, leading to
discontinuities. The SWIR 2 dark current increases with temperature and
dramatically reduces the dynamic range of the spectrometer.

The Spectralon blank should be used when optimizing and for taking a white
reference measurement. It is not necessary to re-optimize the instrument prior
to the recollection of the white reference.

When saving reflectance data, point the probe at the Spectralon once every
few measurements for a minute or two with the same viewing geometry. If the
relative reflectance of the Spectralon is less than or greater than one, a new
white reference may be needed. If the relative reflectance of the Spectralon is
greater than one, re-optimization is recommended.

B.6.3 Other Tips on Discontinuities

Outdoor spectra typically display a great deal of noise in the water bands,
particularly in the 1900 nm region. Indefinable reflectance values due to
atmospheric water absorption bands appear as two zones of very noisy data
(the first zone located approximately between 1350-1400 nm and the other
between 1810-1940 nm). If you look at a typical outdoor spectral irradiance
file, you will see the energy in these bands drop to (or very nearly to) zero.

B.7 Spectrum Averaging (or Sample Count)

If signal levels are low, the only way to increase S/N is by reducing noise
through spectrum averaging. However, spectrum averaging takes more time
per spectrum.

The drawback to this is that the resultant data can be compromised by
introducing low-frequency noise factors, such as varying cloud conditions or
sudden gusts of wind changing the color of the tree canopy.
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To reduce the effects of low-frequency noise conditions like those found
outdoors we recommend taking multiple spectra with spectrum averaging set
to 10-25, then further average those spectra in post-processing using the
ViewSpec program. ViewSpec also permits viewing large groups of files.

B.8 Temperature Effects

The FieldSpec spectroradiometer instruments have thermo-electrically cooled
SWIR detectors (to -25 C), significantly reducing noise in those areas.

If the FieldSpec spectroradiometer is exposed to direct sunlight, depending on
the intensity of the sunlight, the effective operating period may be shortened.

When the system fails due to extreme temperature, it will fail gradually but
the data won't make perfect sense. Shut down and let the instrument cool
before operating again.

You may also see the FieldSpec spectroradiometer saturate in the SWIR 2
region if the instrument is still coming to equilibrium from a cooler
environment to a warmer environment. Frequent re-optimizations will address
this problem until the instrument comes to equilibrium.

The ASD applications provide a warning when the SWIR detectors are out of
thermal regulation.

B.9 Technical Support

If you have any questions or concerns, please contact ASD Inc. by phone, fax,
or email:

Phone: 303-444-6522 X-144
Fax: 303-444-6825

email: support@asdi.com
Web: www.asdi.com

ftp: ftp.asdi.com

Technical support is committed to providing you with a timely response to
your questions. We will work with you to provide solutions to your
applications. Technical support is available to answer your questions Monday
thru Friday, 8 am to 5 pm Mountain Standard Time. We will happily respond
to your e-mail queries as well.
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B.10 W.E.E.E. Compliance

Analytical Spectral Devices supports the W.E.E.E. Regulation. ASD marks
the instruments with the symbol at the left to show that this product has
entered the market place after August 13, 2005.

general waste. ASD will accept the return of your instrument for recycling
purposes. Contact ASD Customer Service to arrange for return of your

E If you decide to end the use of the spectrometer, please do not discard it as
o instrument.
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Notes:
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